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INTRODUCTION
Welcome to HeavyBid Classroom Training. Use this booklet as a classroom supplement to gain a general understanding 
of the software. We start by covering important concepts that you must understand in order to use the system, and then 
we discuss the estimating process in HeavyBid.
The Appendix contains a summary of basic concepts, a glossary, and a list of more ways to learn about HeavyBid. 
If you need information beyond that provided by the classroom training or this booklet, remember that your HCSS 
Support Team is only one call away.
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IMPORTANT CONCEPTS

Master Estimate
The master estimate is a template used to create new working estimates. It should contain common setup information 
used in working estimates, such as labor, equipment, crews, calendars, overtime rules, and worker’s compensation. A 
PDVWHU�HVWLPDWH�ZLOO�UDUHO\�KDYH�ELGLWHPV�DQG�DFWLYLWLHV�LQ�LW�EHFDXVH�WKHVH�LWHPV�DUH�VSHFL¿F�WR�LQGLYLGXDO�HVWLPDWHV��
In HeavyBid, you can set up multiple master estimates. This is particularly useful for companies that perform work 
in multiple counties or states in which different labor and equipment rates apply, or for companies that perform both 
public and private work. 
New estimates are made by creating a copy of an existing estimate. This is the principle behind the master estimate 
template. We recommend you keep labor and equipment costs updated in your master estimates so that they apply to 
any new estimate created from the master. In HeavyBid, ESTMAST is set as the default master estimate; however, you 
FDQ�FUHDWH�QHZ�PDVWHU�HVWLPDWHV�WR�EHVW�¿W�\RXU�QHHGV�

Estimate Structure
The structure of an estimate in HeavyBid is as follows:
 ƒ Estimates contain biditems. A biditem is an item that is required by the client to be performed by the contractor. It 

is part of the basis on which the contractor will be paid. In HeavyBid, it can be a pay item, a place to put overhead 
costs, or it can represent a line of text on a bidform (such as a header or subtotal).

 ƒ Biditems contain activities. An activity is a function of work that must be completed to make up part or all of a 
biditem. Biditems can contain multiple activities.

 ƒ Activities contain resources. A resource can be a labor craft, piece of equipment, material, or subcontractor.
 ƒ Resources contain cost and are the lowest level of detail in an estimate.
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Resources
Resources are the lowest level of detail in an estimate and include labor, equipment, materials, and 
VXEFRQWUDFWRUV��5HVRXUFHV�KROG�FRVWV�IRU�WKHVH�GLIIHUHQW�FRVW�W\SHV��7KHUH�DUH�¿�YH�VWDQGDUG�UHVRXUFH�FRVW�W\SHV�
that can be added to an estimate:

Labor (“A-Z”)

Labor codes start with a letter (e.g., FOREMAN, OPERATOR). In most cases, labor resources refer to labor crafts 
rather than individual employees.

Equipment (“8”)

Equipment codes start with “8” (e.g., 8DOZER, 8PCKUP).

Permanent Materials (“2”)

Permanent material codes start with “2” (e.g., 2ASPHALT, 2A8100). Permanent materials are materials that are used 
RQ�WKH�MRE�DQG�UHPDLQ�RQFH�FRQVWUXFWLRQ�LV�¿�QLVKHG��VXFK�DV�DJJUHJDWH��DVSKDOW��FRQFUHWH��DQG�SLSH�

Construction Materials (“3”)

Construction material codes start with “3” (e.g., 3FORMWRK, 3LUMBER). Construction materials are materials 
WKDW�DUH�XVHG�RQ�D�MRE�DQG�DUH�GHVWUR\HG�GXULQJ�FRQVWUXFWLRQ�RU�UHPRYHG�ZKHQ�LW�LV�¿�QLVKHG��VXFK�DV�IRUPZRUN��WUDI¿�F�
barricades, and plywood.

Subcontractors (“4”)

Subcontractor codes start with “4” (e.g., 4SUB, 4ASPHALTSUB).

Notes
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Types of Data
HeavyBid stores information in two types of data: estimate data and system-wide data.

Estimate Data
(VWLPDWH�GDWD�FRQWDLQV�LQIRUPDWLRQ�VSHFL¿F�WR�D�VLQJOH�HVWLPDWH��)RU�H[DPSOH��LI�\RX�FKDQJH�ODERU�RU�HTXLSPHQW�UDWHV�
in one estimate, it does not affect other estimates. Some estimate data that are regularly used include the following:
 ƒ Biditems
 ƒ Equipment
 ƒ Local Material/Other Resources
 ƒ Labor
 ƒ Crews

On the Setup tab, estimate data can be accessed from the Estimate group.

System-Wide Data
6\VWHP�ZLGH�GDWD�FRQWDLQV�LQIRUPDWLRQ�WKDW�LV�QRW�VSHFL¿F�WR�D�VLQJOH�HVWLPDWH��DQG�FDQ�EH�XVHG�LQ�DQ\�HVWLPDWH�DV�
necessary. This information is located in the following screens:
 ƒ Biditem Codebook
 ƒ Activity Codebook
 ƒ System-Wide Material/Other Resources Codebook
 ƒ Equipment Codebook (Comprehensive versions only)
 ƒ System Quote Folders

On the Setup tab, system-wide data can be accessed from the System group.
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Data Entry
HeavyBid uses many databases to store estimate and codebook information. When you enter data, HeavyBid 
DXWRPDWLFDOO\�VDYHV�\RXU�HQWHUHG�LQIRUPDWLRQ�HDFK�WLPH�\RX�PRYH�WKH�FXUVRU�WR�WKH�QH[W�GDWD�¿�HOG��7KLV�LV�GRQH�E\�
pressing the DOWN ARROW, TAB, or ENTER key. 
You can also manually save at any time by clicking the  save icon, pressing F2, or pressing CTRL+S on your 
keyboard. When you have data that needs to be saved, HeavyBid alerts you with a red stop sign 

 save icon, pressing F2, or pressing CTRL+S on your 
 at the top-left of the 

active window.

:KLOH�HQWHULQJ�GDWD��\RX�FDQ�PRYH�WKH�FXUVRU�WR�WKH�QH[W�¿�HOG�E\�SUHVVLQJ�WKH�7$%�RU�(17(5�NH\��<RX�FDQ�DOVR�VHOHFW�
GLIIHUHQW�¿�HOGV�ZLWK�WKH�PRXVH�

Keyboard Shortcuts
Use keyboard shortcuts to perform common tasks in HeavyBid without using the mouse. Shortcuts are usually faster 
than using the mouse for the same function.
F1 Display help topic for the current view
F2 Save data being edited
F4 Show list of items to select from
F5 Abandon changes to the current record (also CTRL+R)

For more keyboard shortcuts, see “Cursor Movement” on page 45.

Ribbon Menu
To reduce mouse clicks, leave the ribbon menu open so you can easily see and access the options available.
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ESTIMATING OVERVIEW
There are two types of estimates in HeavyBid: working estimates and master estimates.
 ƒ Working Estimates: Jobs that you plan to bid on.
 ƒ Master Estimates��7HPSODWHV�FRQWDLQLQJ�WKH�QHFHVVDU\�VHWXS�¿OHV�WKDW�\RXU�ZRUNLQJ�HVWLPDWHV�ZLOO�EH�EDVHG�XSRQ��

By default, all newly created estimates are listed in the Open Estimate window > Estimate List tab.

To set an existing estimate as a master estimate, do the following:
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To set a new estimate as a master estimate, do the following:

Notes
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Setting Up a Master Estimate
In this section, learn the basics for setting up a master estimate. This booklet references the ESTMAST estimate for 
the default master estimate. However, a new master estimate can be created (see “Creating a New Estimate” on page 
18).

Open the Master Estimate
1. On the File tab, select Open. The Open Estimate window opens.
2. Select the Master Estimates tab, and then select ESTMAST (Blank Master Estimate). 
3. Click the OK button, and watch as the title bar at the top of the screen changes to display the code and name of 

the estimate that is currently open.

Notes
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Labor Setup
Setup tab > Labor

In HeavyBid��ODERU�UHVRXUFHV�DUH�VHW�XS�WR�FRUUHVSRQG�ZLWK�HDFK�VSHFL¿�F�SD\�FODVV�WKDW�\RXU�FRPSDQ\�XVHV��
7\SLFDOO\��VSHFL¿�F�HPSOR\HHV�DUH�QRW�VHW�XS�LQ�HeavyBid. Rather, the labor craft is used to estimate the costs of 
the labor resources. HeavyBid allows as many labor resources as desired, but each must be set up individually.

1. On the Setup tab, select Labor. The Labor Setup window opens.
2. Click the Insert Row button, and then enter a labor code that begins with an alpha character. 
3. 3UHVV�WKH�7$%�NH\�RU�XVH�WKH�PRXVH�WR�PRYH�WR�WKH�'HVFULSWLRQ�¿�HOG��(QWHU�WKH�UHVRXUFH�GHVFULSWLRQ��
4. &RQWLQXH�LQ�WKLV�IRUPDW�WR�PRYH�WKURXJK�WKH�¿�HOGV�DQG�LQVHUW�WKH�UDWH��XQLW��DOPRVW�DOZD\V�0+�IRU�PDQKRXUV���WD[��

and fringe. Once these values are entered, tab through the end of the line. When the next line is highlighted, it 
automatically saves your entered labor resource.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ�>ĂďŽƌ

 ƒ Labor is one of the types of resources added into activities when building an estimate.
 ƒ In order to be used with crews, a labor craft must use MH (manhours) as its unit.
 ƒ By clicking the Tax % and Fringe $ Headers, you can break out the costs for this burden, or you can simply use a 

percentage and enter it into the Labor Setup window.
 ƒ The estimate’s default overtime rule will be applied for any labor resource that does not have an overtime rule 

VSHFL¿�HG��7R�OHDUQ�KRZ�RYHUWLPH�UXOHV�DUH�FUHDWHG�DQG�DSSOLHG��VHH�³2YHUWLPH�5XOH�6HWXS´�RQ�SDJH����
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 Overtime Rule Setup
^ĞƚƵƉ�ƚĂď�х�KǀĞƌƟ�ŵĞ�ZƵůĞƐ

Overtime rules are used in HeavyBid to create the necessary premium percentage to calculate dollars for 
overtime hours. Without overtime rule, estimated manhours do not incur overtime costs where applicable. 
Once an overtime rule is set up and applied to the estimate, HeavyBid�XVHV�WKH�VKLIWV�VSHFL¿�HG�WKURXJKRXW�WKH�
estimate to help calculate overtime costs in each activity.

1. On the Setup tab, select Overtime Rules. The Overtime Rule Setup window opens.
2. Enter an OT Rule code and a description for the overtime rule. 
3. Enter the proper rules for your company’s overtime, and then click Save. In the example below, laborers earn time 

and a half after 8 hours on weekdays, time and a half all day on Saturdays, and double time all day on Sundays.

�Ō�Ğƌ�ĐůŝĐŬŝŶŐ�^ĂǀĞ͕�ǇŽƵƌ�ĞŶƚĞƌĞĚ�
ŝŶĨŽƌŵĂƟ�ŽŶ�ǁŝůů�ďĞ�ĐůĞĂƌĞĚ�ĨƌŽŵ�
ƚŚĞ�Į�ĞůĚƐ͕�ďƵƚ�ŝƚ�ŚĂƐ�ďĞĞŶ�ƐĂǀĞĚ͘�
dŽ�ƐĞĞ�ǇŽƵƌ�ĞŶƚĞƌĞĚ�ŝŶĨŽƌŵĂƟ�ŽŶ�
ĂŐĂŝŶ͕�ƐĞůĞĐƚ�ƚŚĞ�ƌƵůĞ�ĨƌŽŵ�ƚŚĞ�
Kd�ZƵůĞ�Į�ĞůĚ͘

�ĞĨĂƵůƚ�KǀĞƌƟ�ŵĞ

After creating an overtime rule, specify the default overtime rule used by your company. To do this, select Setup tab 
> Estimate Information. On the Estimate Information Setup window, select the default overtime rule for your master 
estimate, and then click Save.

^ĂůĂƌŝĞĚ�KǀĞƌƟ�ŵĞ

Because salaried employees do not 
receive compensation for overtime, 
HeavyBid allows you to choose 
an overtime rule for salaried 
employees that will adjust their 
premium percentage, based on the 
calendar used for the activity.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ�KǀĞƌƟ�ŵĞ�ZƵůĞƐ

 ƒ You can set up as many overtime rules as necessary in an estimate.
 ƒ If a labor class does not use the default overtime rule, the correct overtime rule can be selected for the labor class 

individually from the Labor Setup window.
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Calendar Setup
^ĞƚƵƉ�ƚĂď�х��ĂůĞŶĚĂƌƐ

For HeavyBid to determine overtime hours and shift durations, calendars must be set up and applied to the 
estimate. HeavyBid calculates hours and overtime premiums according to the selected calendar for each 
activity.

1. On the Setup tab, select Calendars. The Work Week Calendar Setup window opens.
2. Enter a calendar code and a description for the calendar. 
3. Enter the total estimated hours worked per shift for each day of the week. This is used in conjunction with 

overtime rules to calculate the premium percentage for overtime rates. 
4. Pay special attention to the Hours/Shift for Production value. Typically, this option is the hour amount for a 

single shift. It is used to dictate the productivity level of the crew using the calendar. If unsure as to the use of this 
RSWLRQ��LQVHUW�WKH�GXUDWLRQ�LQ�KRXUV�RI�D�VLQJOH�VKLIW��DV�VSHFL¿�HG�LQ�WKH�GD\�WDEOH�

5. Click Save. When asked to update estimate with new setup information, select No (this is the master estimate and 
there is nothing to update).

�Ō�Ğƌ�ĐůŝĐŬŝŶŐ�^ĂǀĞ͕�ǇŽƵƌ�ĞŶƚĞƌĞĚ�
ŝŶĨŽƌŵĂƟ�ŽŶ�ǁŝůů�ďĞ�ĐůĞĂƌĞĚ�ĨƌŽŵ�
ƚŚĞ�Į�ĞůĚƐ͕�ďƵƚ�ŝƚ�ŚĂƐ�ďĞĞŶ�ƐĂǀĞĚ͘�
dŽ�ƐĞĞ�ǇŽƵƌ�ĞŶƚĞƌĞĚ�ŝŶĨŽƌŵĂƟ�ŽŶ�
ĂŐĂŝŶ͕�ƐĞůĞĐƚ�ƚŚĞ�ĐĂůĞŶĚĂƌ�ĨƌŽŵ�
ƚŚĞ��ĂůĞŶĚĂƌ�Į�ĞůĚ͘

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ĂůĞŶĚĂƌƐ

 ƒ Calendars are used with overtime rules to calculate overtime premium percentages. This percentage is applied 
to all hours worked in an activity. A premium percentage is calculated by dividing the number of hours paid by 
WKH�QXPEHU�RI�KRXUV�ZRUNHG��7KH�GHIDXOW�SUHPLXP�¿�HOG�GLVSOD\V�WKH�FXUUHQW�SUHPLXP�SHUFHQWDJH�EDVHG�RQ�WKH�
currently selected overtime rule for the estimate. 

 ƒ To enter an override premium percentage for use in the estimate, select the Use Override Premium check box. Do 
not select this option unless it is necessary to change this percentage.

 ƒ To compare the premium percentages based on different overtime rules with different calendars, click the Check 
Premium % button.

Notes



14 HCSS HeavyBid Classroom Training

Equipment Setup
^ĞƚƵƉ�ƚĂď�х��ƋƵŝƉŵĞŶƚ

Equipment Setup is used to set the rental rates, fuel rates, and other operating expenses for equipment. 
Equipment should be set up similarly to labor in that actual equipment pieces do not need to be entered 
here, but rather classes of equipment. If you have multiple types of the same piece of equipment (e.g., a 
D5 dozer), you do not need to insert the equipment in multiple times unless the rental rate for the pieces 

is drastically different.

1. On the Setup tab, select Equipment. The Equipment Setup window opens. 
Equipment resource codes must begin with “8”, after which you can use any alphanumeric combination. As labor 
must use a unit type of MH (manhours) to be used in a crew, equipment must also use a unit type of HR (hour) to 
be used in a crew. 

2. /LQN�DQ�RSHUDWRU�WR�WKH�SLHFH�RI�HTXLSPHQW��$Q�RSHUDWRU�IURP�WKH�ODERU�VHWXS�FDQ�EH�VSHFL¿�HG�IRU�D�SLHFH�RI�
equipment by clicking on the Operator >> column header as you create each new equipment resource. 

3. Enter an hourly rental rate and fuel rate. These are broken apart here so you can categorize the dollar amounts 
correctly. 

4. For a more advanced breakdown of equipment operating expenses (EOE), click the Rent Breakdown and EOE 
Breakdown tabs (Advanced and Comprehensive Systems only).

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ƋƵŝƉŵĞŶƚ

 ƒ Use a consistent numbering scheme for your equipment codes. For example, use the same starting characters for 
similar kinds of equipment so that they group together in equipment lists (e.g., 8D for dozers, 8L for loaders, 8E 
for excavators). This will organize your equipment selection lists.

 ƒ The Rent Rate and the Fuel Rate are added together into the Total Rate. If you have additional operational 
expenses, simply add them into the Fuel Rate value or use the EOE Breakdown tab to break these costs into sub-
categories. 
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Crew Setup
^ĞƚƵƉ�ƚĂď�х��ƌĞǁƐ

Crews are one of the most powerful tools in HeavyBid��%\�XVLQJ�FUHZV��\RX�FDQ�LQFUHDVH�HI¿�FLHQF\�E\�
minimizing the need to build labor and equipment combinations. Prepare them in advance so that when you 
begin estimating, you can quickly input labor and equipment cost. 

1. On the Setup tab, select Crews. The Crew Setup window opens. 
2. ,Q�WKH�&UHZ�¿�HOG��HQWHU�D�FRGH�XS�WR�VL[�FKDUDFWHUV�LQ�OHQJWK��
3. ,Q�WKH�'HVF�¿�HOG��HQWHU�WKH�FUHZ�GHVFULSWLRQ��
4. Click the Equip and Labor buttons to select labor and equipment resources for this crew.

If you select an equipment piece with an attached operator, you will be prompted to pull in the operator as a labor 
resource, thereby minimizing the time required to build a crew. 

5. To attach a subcontractor resource to the crew, click the Resource column header and select the resource from the 
list.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ƌĞǁƐ

 ƒ When used in an estimate, crews allow you to modify hours and productivity for several pieces of labor and 
equipment at once.

 ƒ Only create your most commonly used crews. It is not necessary to create a crew for every possible crew 
FRPELQDWLRQ�EHFDXVH�\RX�FDQ�PRGLI\�DQ\�FUHZ�IRU�VSHFL¿�F�XVH�LQ�D�VLQJOH�DFWLYLW\��7KLV�EHQH¿�W�DOORZV�À�H[LELOLW\�
and creativity when working to build your estimate. 

 ƒ Labor and equipment must be set up before crews can be created.
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Worker’s Comp Setup
^ĞƚƵƉ�ƚĂď�х�tŽƌŬĞƌ͛Ɛ��ŽŵƉ

Use the Worker’s Comp Setup window to enter the worker’s comp codes and percentages that you need 
for your estimates. These codes can later be assigned to activities in the estimate. The worker’s comp cost, 
calculated based on the labor cost in the activity, will then be included in the total cost for that activity.

1. On the Setup tab, select Worker’s Comp. The Worker’s Comp Setup window opens.
2. For each worker’s compensation code that you need to account for, provide its code, description, and the 

SHUFHQWDJH�GH¿�QHG�IRU�WKH�ZRUNHU¶V�FRPSHQVDWLRQ��
3. $�¿�HOG�IRU�D�PDULQH�XSVKLIW�IDFWRU�LV�DYDLODEOH�KHUH�DV�ZHOO��JLYLQJ�\RX�IXUWKHU�À�H[LELOLW\�WR�GHVLJQDWH�VSHFL¿�F�

activities in the estimate as marine work and increasing the worker’s compensation by this factor.

Completion of the Master Estimate
Once all items are entered into the master estimate, it is automatically saved and ready for immediate use. New 
estimates are now created based on the data entered into the master estimate, eliminating multiple instances of entry 
into the system. 
$IWHU�WKH�PDVWHU�HVWLPDWH�VHWXS�LV�FRPSOHWH��LW�W\SLFDOO\�LV�QRW�PRGL¿�HG�XQOHVV�D�FKDQJH�QHHGV�WR�EH�PDGH�WR�WKH�VHWXS�
information. Changes that should be made in the master estimate include rate increases for labor and equipment and 
FUHZ�UHVWUXFWXULQJ��1HYHU�FUHDWH�ELGLWHPV��DFWLYLWLHV��RU�RWKHU�W\SHV�RI�HVWLPDWH�VSHFL¿�F�LQIRUPDWLRQ�LQ�WKH�PDVWHU�
estimate unless that information will be used in all future estimates. 
Note that if you create estimates and then modify the master estimate afterwards, your changes do not affect existing 
estimates. Your changes only affect future estimates that are created from the master. If you need to make mass 
changes to rates, crews, labor, equipment, etc., call your HCSS Support Team for assistance.
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Notes
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Creating a New Estimate
1RZ�WKDW�WKH�PDVWHU�HVWLPDWH�LV�HVWDEOLVKHG��QHZ�ZRUNLQJ�HVWLPDWHV�FDQ�EH�FUHDWHG��:RUNLQJ�HVWLPDWHV�DUH�GH¿QHG�DV�
actual estimates that contain cost and price information that will be submitted to an owner.

1. On the File tab, select New > New Estimate. The New Estimate wizard opens.
2. Enter an estimate code of up to eight characters. This is the code HeavyBid uses to sort estimates; therefore, we 

UHFRPPHQG�WKDW�\RX�HVWDEOLVK�D�FRGLQJ�PHWKRG�LQ�RUGHU�WR�EHVW�GH¿QH�\RXU�HVWLPDWHV��
In almost all instances, you should not change the Folder of Estimates. This changes the directory in which 
estimates are stored and can cause much confusion and problems if used incorrectly. The default location should 
be used at all times except in extremely rare instances.

3. Click the Next button to proceed. 
4. Enter an estimate name to provide a better description of your estimate, and then click Next.
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5. 7KH�QH[W�VFUHHQ�GH¿QHV�ZKHUH�WKLV�QHZ�HVWLPDWH�ZLOO�REWDLQ�LWV�VRXUFH�GDWD��7KLV�VKRXOG�W\SLFDOO\�EH�WKH�PDVWHU�
estimate that contains all the setup items as referenced in the previous section. 
By default, HeavyBid uses ESTMAST as the default master estimate, and it automatically appears as the source 
HVWLPDWH�LQ�WKLV�VFUHHQ��'R�QRW�PDNH�DQ\�FKDQJHV�WR�WKH�6RXUFH�(VWLPDWH�¿HOG�XQOHVV�\RX�QHHG�WR�VHOHFW�D�GLIIHUHQW�
master estimate. If this is the case, click the �VHOHFWLRQ�EXWWRQ�LQ�WKH�6RXUFH�(VWLPDWH�¿HOG�WR�VHOHFW�DQRWKHU�
estimate to be used as the master.

6. Click the Finish button to complete the New Estimate wizard and open your new estimate.

Notes
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Working in a New Estimate
This section discusses the many screens initially used when working in an estimate. Note that there are many other 
screens and options that are not discussed in this booklet. The intent of this section is to provide an overview of how 
to work through an estimate on your own. If you encounter a problem that is not referenced in this booklet, press the 
F1 key to access HeavyBid’s extensive help system.

Estimate Information
^ĞƚƵƉ�ƚĂď�х��ƐƟ�ŵĂƚĞ�/ŶĨŽƌŵĂƟ�ŽŶ

$IWHU�FUHDWLQJ�D�QHZ�HVWLPDWH��H[DPLQH�WKH�(VWLPDWH�,QIRUPDWLRQ�6HWXS�ZLQGRZ��+HUH��\RX�ZLOO�¿�QG�
HVWLPDWH�VSHFL¿�F�LQIRUPDWLRQ��LQFOXGLQJ�WKH�IROORZLQJ�

 ƒ Estimate code and name
 ƒ Labor rules (calendar, overtime, and worker’s comp)
 ƒ Sales tax
 ƒ Minority goals

These items establish a default basis upon which HeavyBid�ZLOO�FUHDWH�WKH�HVWLPDWH��7KH\�FDQ�EH�PRGL¿�HG�ODWHU�DV�
necessary to update the estimate with different values, but it is best to examine these items before beginning work in 
the estimate.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ƐƟ�ŵĂƚĞ�/ŶĨŽƌŵĂƟ�ŽŶ

 ƒ To attach documents to the estimate in this window, click the  attachment icon.
 ƒ To save your changes, click the  save icon, press the F2 key, or press CTRL+S.
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Notes
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Biditem Setup
^ĞƚƵƉ�ƚĂď�х��ŝĚŝƚĞŵƐ

The Biditem Setup screen is where the schedule of items from the owner of a job should be inserted into 
an estimate. As in most screens in HeavyBid, enter new biditems from left to right, starting with the biditem 
number. We recommend a numbering sequence such as 10, 20, 30, etc., to allow additional biditems to be 
HDVLO\�LQVHUWHG�DV�QHFHVVDU\��,I�\RX�¿�QG�WKDW�\RXU�RULJLQDO�QXPEHULQJ�LV�WRR�UHVWULFWLYH��FOLFN�WKH�2SWLRQV�EXWWRQ�

to renumber your biditems.

Biditem Types

The Biditem Setup screen contains a Type column. There are several types of biditems in HeavyBid, each allowing for 
different uses:
 ƒ Direct (D) – A direct biditem always shows up as a line item in the proposal. It is a line item required by the 

owner, and once the estimate is priced out, direct biditems price out with all of the dollars in the estimate.
 ƒ Indirect (I) – An indirect biditem is used to categorize costs that are required to complete the job, but would not 

necessarily be categorized under direct biditems. A typical indirect cost is company overhead or contingency 
LWHPV�VSHFL¿�HG�E\�\RXU�FRPSDQ\�

 ƒ Non-Additive (N) – A non-additive biditem is often used to hold costs for alternate items. When set as a non-
additive type, its cost is not added to the totals of the estimate. Non-additive biditems are also used for subtotals 
and headers in various proposals and reports.

 ƒ Holding Account (H)�±�$�KROGLQJ�DFFRXQW�ELGLWHP�LV�XVHG�WR�KROG�FRVWV�WKDW�ZLOO�EH�VSUHDG�EDFN�DV�FRVW�WR�VSHFL¿�F�
direct biditems. These are similar to indirect items, but typically contain direct cost dollars. A typical example 
of a holding account is a batch plant. Holding account biditems are available in Advanced and Comprehensive 
versions. 

 ƒ Equipment Account (E) – An equipment account biditem is used to generate the rent of a piece of equipment 
to be used in the estimate. It must be used in conjunction with an alternate rent calculation. Equipment Account 
biditems are available only in Comprehensive versions.

Notes
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Biditem Quantities

After specifying the type of biditem, complete the biditem record by entering a Bid Quantity, Unit type, and Takeoff 
Quantity. 
 ƒ 7KH�%LG�4XDQWLW\�VKRXOG�DOZD\V�EH�WKH�DPRXQW�VSHFL¿HG�E\�WKH�RZQHU�DQG�ZLOO�VKRZ�XS�RQ�SURSRVDOV�E\�GHIDXOW��
 ƒ The Takeoff Quantity is intended to have been measured and examined by your company. This is the value that 

costs are based on to generate a unit price. 

�ĚĚŝƟŽŶĂů�/ŶĨŽƌŵĂƟŽŶ�ŽŶ��ŝĚŝƚĞŵƐ

 ƒ 7R�LPSRUW�ELGLWHPV�IURP�0LFURVRIW�([FHO��WH[W��RU�'27�¿OHV��VHOHFW�)LOH�WDE�!�,PSRUW�
 ƒ Bid and Takeoff Quantity differences can cause confusion when pricing your estimate if you do not understand 

how HeavyBid handles these quantity differences. We recommend you read the HeavyBid help on this topic or 
discuss it with HCSS Technical Support.

Notes
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Estimate Entry – Tree View
�ƐƟ�ŵĂƚĞ�ƚĂď�х�dƌĞĞ�sŝĞǁ

The Estimate Entry – Tree View screen is the recommended method of cost entry for practicality and ease 
RI�XVH��$�OLVW�RI�ELGLWHPV��DFWLYLWLHV��DQG�UHVRXUFHV�DUH�DYDLODEOH�RQ�WKH�OHIW�VLGH��ZKLOH�VSHFL¿�F�DFWLYLW\�DQG�
resource details can be entered at the right. This layout makes the Tree View screen a very powerful element 
in HeavyBid.

Tree View Overview

In the Tree View, you can do the following:
 ƒ &UHDWH�ELGLWHPV�RQ�WKH�À�\�E\�ULJKW�FOLFNLQJ�RQ�WKH�OHIW�SDQH�DQG�VHOHFWLQJ�$GG�%LGLWHP�RSWLRQ�
 ƒ Create activities directly on the screen or by clicking the Add Activities button at the bottom-left.
 ƒ Add resources directly into the Resource Detail tab, or click the Select Labor/Equipment/Material icons at the 

right to pull in resources. 

The costs within biditems are contained within activities. A biditem can contain as many activities to break down the 
work of the biditem as necessary. Within each activity resides the actual resources, which are the cost of the estimate. 
Therefore, creating and using activities is the way to build cost within the estimate.
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Create Activities

1. In the left pane, select the biditem that you would like to create an activity for.
2. :LWK�WKH�ELGLWHP�KLJKOLJKWHG��FOLFN�LQ�WKH�$FWLYLW\�¿�HOG�LQ�WKH�$FWLYLW\�,QIRUPDWLRQ�VHFWLRQ�DW�WKH�ULJKW�
3. Enter a code for the activity (or click the  selection button to pull from the activity codebook), and then press 

the TAB key to progress, setting up the description, quantity, and type along the way. 
4. %\�GHIDXOW��WKH�FDOHQGDU�DQG�ZRUNHUV�FRPS��FRGH�VSHFL¿�HG�LQ�WKH�(VWLPDWH�,QIRUPDWLRQ�VFUHHQ�LV�FDUULHG�LQWR�WKLV�

activity. These can be changed for a single activity by selecting the corresponding  button and selecting the 
appropriate item.

5. If using a crew, enter the crew code or click the  selection button to pull form a list. Set the productivity type 
and rate. To save the crew, tab through the remainder of the lines until you reach the Resource Detail tab.

6. On the Resource Detail tab, select materials or other resources by clicking the Resource>> header to select from a 
list, changing quantities as needed.

ZĞƐŽƵƌĐĞƐ�ǁŝƚŚ�͞ссх͟�Ăƚ�ƚŚĞ�ďĞŐŝŶŶŝŶŐ�ŽĨ�ƚŚĞŝƌ�ĚĞƐĐƌŝƉƟ�ŽŶƐ�ĂƌĞ�ŶŽƚ�ƉĂƌƚ�ŽĨ�Ă�ĐƌĞǁ͘�dŚŝƐ�ŵĞĂŶƐ�ƚŚĂƚ�ƚŚĞǇ�ĚŽ�ŶŽƚ�Ăī�ĞĐƚ�Ă�
ĐƌĞǁ͛Ɛ�ƉƌŽĚƵĐƟ�ŽŶ͕�ĂŶĚ�ĐŚĂŶŐĞƐ�ƚŽ�Ă�ĐƌĞǁ͛Ɛ�ƉƌŽĚƵĐƟ�ŽŶ�ĚŽ�ŶŽƚ�Ăī�ĞĐƚ�ƚŚĞŵ͘

Notes
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Add/Sort Activities

To add or sort activities, right-click on a biditem or click the Add Activities button at the bottom-left. In the Add/Sort 
Activities screen, you can do the following:
 ƒ &UHDWH�PXOWLSOH�DFWLYLWLHV�RQ�WKH�À\�RU�SXOO�WKHP�LQ�IURP�WKH�DFWLYLW\�FRGHERRN�
 ƒ Change the order of activities. To change the order, do the following:

1. At the bottom of the screen, ensure the “Save in order activities are displayed in the grid” option is selected.
2. In the grid, click on the activity that you want to reorder.

3. At the bottom of the scren, click the     arrow buttons to reorder the highlighted activity.

Select Resources

To select resources for an activity, select the activity in the left pane. At the right, click the Resource >> column 
header on the Resource Detail tab. In this screen, you can do the following:
 ƒ Pull in multiple resources at once.
 ƒ Select from local or system-wide resources, as well as resources already used in the estimate.
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Modify Crew

8VH�WKH�0RGLI\�&UHZ�VFUHHQ�WR�FXVWRPL]H�WKH�FUHZ�LQ�D�VSHFL¿�F�DFWLYLW\��,W�LV�DFFHVVHG�E\�FOLFNLQJ�WKH�FUHZ�
icon at the right. 

Changes here only affect the crew in the current activity, not crews in other activities.

In the Modify Crew screen, you can do the following:
 ƒ Use the Pieces column to add, delete, or modify the number of crew resources.
 ƒ Change the productivity type, productivity rate, and crew hours. Doing so automatically recalculates all of the 

crew’s resources’ quantities.
 ƒ Use the Hour Adj. column to change labor resources without affecting the productivity rate. For example, use it to 

add an extra hour at the end of each shift for your foreman to complete paperwork. 

Notes
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Handling Material and Subcontractor Quotes
^ƵďƐǇƐƚĞŵƐ�ƚĂď�х�YƵŽƚĞƐ

Use the Quote Subsystem to track all material and subcontractor quotes you receive during the bidding 
process. For companies that choose to track quotes outside of HeavyBid, see “Changing Subcontractor & 
Material Costs Without Using the Quote System” on page 32.

To properly use the HeavyBid Quote system, you must complete the following steps:
1. Add quote folders
2. Add resources to quote folders
3. Add vendors to quote folders

a. Enter vendor prices
b. Select a vendor

Add Quote Folders
1. In the Quote Summary screen, click the Quote Sheet link at the right. The Quote Sheet window opens.
2. ,Q�WKH�4XRWH�)ROGHU�¿�HOG��HQWHU�D�QHZ�TXRWH�IROGHU�FRGH�
3. 7DE�WR�WKH�QH[W�¿�HOG��DQG�WKHQ�HQWHU�D�GHVFULSWLRQ�IRU�WKH�TXRWH�IROGHU��
4. Select whether the quote folder will contain subcontract items or materials. 
5. Click in the grid. The quote folder is now added to your estimate.

dŽ�ƐĞĞ�ŽƚŚĞƌ�ǁĂǇƐ�ƚŽ�ĂĚĚ�ƋƵŽƚĞ�ĨŽůĚĞƌƐ͕�ƉƌĞƐƐ�ƚŚĞ�&ϭ�ŬĞǇ�ǁŚŝůĞ�ŝŶ�Ă�ƋƵŽƚĞ�ƐŚĞĞƚ͘�/Ŷ�ƚŚĞ�,Žǁ�dŽ�ƐĞĐƟ�ŽŶ͕�ƐĞůĞĐƚ�ƚŚĞ�͞�ĚĚŝŶŐ�
YƵŽƚĞ�&ŽůĚĞƌƐ�ƚŽ�ĂŶ��ƐƟ�ŵĂƚĞ͟�ŽƉƟ�ŽŶ͘�

Notes
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Add Resources to Quote Folders
1. ,Q�WKH�4XRWH�6KHHW�ZLQGRZ��VHOHFW�D�TXRWH�IROGHU�LQ�WKH�4XRWH�)ROGHU�¿�HOG��
2. Click the Add Resources to Quote Folders link to open the Select Resources for Quote Folder window. 
3. Click the box to the left of the desired resource(s). This places a check mark next to the resource and pulls every 

occurrence of the selected resource in your estimate into the folder.
 ƒ 7R�SXOO�HYHU\�RFFXUUHQFH�RI�D�UHVRXUFH�RQO\�ZLWKLQ�VSHFL¿�F�ELGLWHPV��FOLFN�>�@�DW�WKH�OHIW�RI�WKH�GHVLUHG�

resource to expand the tree, and then click the boxes of desired biditems.
 ƒ 7R�SXOO�HYHU\�RFFXUUHQFH�RI�D�UHVRXUFH�RQO\�ZLWKLQ�VSHFL¿�F�DFWLYLWLHV��FOLFN�>�@�DW�WKH�OHIW�RI�WKH�ELGLWHP�WR�

expand the tree, and then click the boxes of desired activities.
4. Click OK. 

dŽ�ƐĞĞ�ŽƚŚĞƌ�ǁĂǇƐ�ƚŽ�ĂĚĚ�ƋƵŽƚĞ�ĨŽůĚĞƌƐ͕�ƉƌĞƐƐ�ƚŚĞ�&ϭ�ŬĞǇ�ǁŚŝůĞ�ŝŶ�Ă�ƋƵŽƚĞ�ƐŚĞĞƚ͘�/Ŷ�ƚŚĞ�,Žǁ�dŽ�ƐĞĐƟ�ŽŶ͕�ƐĞůĞĐƚ�ƚŚĞ�͞�ĚĚŝŶŐ�
YƵŽƚĞ�&ŽůĚĞƌƐ�ƚŽ�ĂŶ��ƐƟ�ŵĂƚĞ͟�ŽƉƟ�ŽŶ͘�

Notes
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Add Vendors to Quote Folders
1. ,Q�WKH�4XRWH�6KHHW�ZLQGRZ��VHOHFW�D�TXRWH�IROGHU�LQ�WKH�4XRWH�)ROGHU�¿�HOG��
2. ,Q�WKH�9HQGRU�¿�HOG��\RX�FDQ�HLWKHU�FUHDWH�D�QHZ�YHQGRU�RU�VHOHFW�DQ�H[LVWLQJ�RQH�

Create a New Vendor

1. Enter a code of up to 12 characters for the vendor (e.g., 
“ACMEPAVE01” for Acme Paving) 

2. Click the Add Vendor button to add the vendor to the grid below. 

�Ğ�ĐŽŶƐŝƐƚĞŶƚ�ǁŝƚŚ�ǇŽƵƌ�ŶĂŵŝŶŐ�ĐŽŶǀĞŶƟ�ŽŶƐ͘�dŚŝƐ�ǁŝůů�ŵĂŬĞ�ŝƚ�ĞĂƐŝĞƌ�ƚŽ�Į�ŶĚ�ƚŚĞ�ǀĞŶĚŽƌ�ůĂƚĞƌ�ǁŚĞŶ�ƉĞƌĨŽƌŵŝŶŐ�ƐĞĂƌĐŚĞƐ͘�
dŚŝƐ�ŝƐ�ĞƐƉĞĐŝĂůůǇ�ŝŵƉŽƌƚĂŶƚ�ŝĨ�ǇŽƵ�ƉůĂŶ�ŽŶ�ůĂƚĞƌ�ŵĂŬŝŶŐ�ƚŚŝƐ�ǀĞŶĚŽƌ�Ă�ƐǇƐƚĞŵͲǁŝĚĞ�ŽŶĞ�ƵƐŝŶŐ�ƚŚĞ��ŽƉǇ�>ŽĐĂů�sĞŶĚŽƌƐ�ƚŽ�
^ǇƐƚĞŵͲtŝĚĞ�sĞŶĚŽƌƐ�ŽƉƟ�ŽŶ͘

Add an Existing Vendor

1. ,Q�WKH�4XRWH�6KHHW�ZLQGRZ��VHOHFW�D�TXRWH�IROGHU�LQ�WKH�4XRWH�)ROGHU�¿�HOG��
2. Click the �VHOHFWLRQ�EXWWRQ�LQ�WKH�9HQGRU�¿�HOG�WR�VHOHFW�IURP�D�OLVW�RI�YHQGRUV��

For those using the Advanced and Comprehensive versions of HeavyBid, this opens the System-Wide Contacts 
window by default. Either select from this list or click the Local Vendors button.
For people using the Basic version of HeavyBid, this opens the All Local Vendors window. 

3. Click on the desired vendor, and then click OK to pull it into the folder and return to the Quote Sheet screen.

Notes
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Add Multiple Vendors at Once (Advanced and Comprehensive Only)

1. Click the Pull In Multiple Vendors link.
2. In the Add column, select the check box of each desired vendor. Or to select all vendors, click the Select All 

button. 
3. Click OK.

dŽ�ŶĂƌƌŽǁ�ĚŽǁŶ�ƚŚĞ�ƐĞůĞĐƟ�ŽŶ�ůŝƐƚ͕�ƐĞůĞĐƚ�Ă�WƌŽĚƵĐƚ�Žƌ�ZĞŐŝŽŶ�ĐŽĚĞ�ŝŶ�ƚŚĞ�KƉƟ�ŽŶĂů�&ŝůƚĞƌƐ�ƐĞĐƟ�ŽŶ͘�;zŽƵ�ŵƵƐƚ�Į�ƌƐƚ�ŚĂǀĞ�
WƌŽĚƵĐƚͬZĞŐŝŽŶ��ŽĚĞƐ�ƐĞƚ�ƵƉ�ŝŶ�ŽƌĚĞƌ�ƚŽ�Į�ůƚĞƌ�ƚŽ�ƚŚĞŵ͘Ϳ

4. $GG�WKH�YHQGRU�SULFHV�LQ�WKH�DSSURSULDWH�¿�HOGV�
5. Click the “Select the Vendor” check box for the desired vendor.

dŚĞ�ƋƵŽƚĞ�ƐƵďƐǇƐƚĞŵ�ĐĂŶ�ďĞ�ĂƵƚŽŵĂƚĞĚ�ƚŽ�ĐƌĞĂƚĞ�ĨŽůĚĞƌƐ͕�ĂĚĚ�ƌĞƐŽƵƌĐĞƐ͕�ĂŶĚ�ƉƵůů�ŝŶ�ǀĞŶĚŽƌƐ�ŝŶƐƚĂŶƚĂŶĞŽƵƐůǇ͘�&Žƌ�ŵŽƌĞ�
ŝŶĨŽƌŵĂƟ�ŽŶ͕�ƉƌĞƐƐ�&ϭ�ĨŽƌ�HeavyBid�ŚĞůƉ͕�Žƌ�ĐĂůů�,�^^�dĞĐŚŶŝĐĂů�^ƵƉƉŽƌƚ͘
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Changing Subcontractor & Material Costs Without Using the Quote System
�Ěŝƚ�ƚĂď�х��ŚĂŶŐĞ��ƐƟŵĂƚĞ��ĂƚĂ�х��ŚĂŶŐĞ�DĂƚĞƌŝĂůͬKƚŚĞƌ�ZĞƐŽƵƌĐĞ��ŽƐƚƐ

Use the Change Material/Other Resource Costs window to review and modify costs for materials and other resources 
within the estimate (not including labor or equipment resources). Access the window through the Edit tab or by 

clicking this  icon on the HeavyBid toolbar.

You can change the cost of material/other resources in a variety of ways:
 ƒ Directly change the unit cost
 ƒ Directly change the total cost
 ƒ Change the sales tax percentage (the % column)
 ƒ &OLFN�WKH�3HUFHQW�EXWWRQ�WR�FKDQJH�WKH�XQLW�FRVW�E\�D�VSHFL¿F�SHUFHQWDJH

Notes
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Summarizing Costs and Finalizing Prices

Bid Summary
^ƵŵŵĂƌǇ�ƚĂď�х�^ƵŵŵĂƌǇ

Markup, addons, bonds, and indirect spreads are handled in the Bid Summary screen. Access this screen by 
selecting Summary tab > Summary or by clicking the summary icon on the toolbar. 

 ƒ On the initial Totals tab, markup can be applied globally to the estimate based on cost type. 
 ƒ Addons and bonds have their own respective tabs that allow you to set up and apply them in different ways. 
 ƒ The Spread Overrides tab provides many different methods to change the way HeavyBid spreads costs across direct 

biditems. 
Bid Summary is one of the most important features in the system because it summarizes all cost in the estimate and 
then creates markup to spread back to direct biditems. It also spreads all other costs not categorized as direct cost and 
generates a balanced bid price for the estimate. 
It is important to understand that by default, HeavyBid creates the totals in this screen based upon takeoff quantity in 
the estimate. This is the true cost in the estimate, and therefore is used as the basis for all markups, addons, bonds and 
indirect spreads. As a result, the total dollar amount shown in the lower right is based on takeoff quantity.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ŝĚ�^ƵŵŵĂƌǇ

 ƒ Use this screen to set the markup for labor, equipment, materials, etc. in the bid and decide how the markup, 
indirect costs, and addon/bond costs are spread.

 ƒ On the Totals tab, use the Standard Spreads section to select the method for each type of spread for indirect, 
markup, and addon/bond dollars. This becomes the basis upon which HeavyBid spreads those costs.

 ƒ After making changes to the cost in the bid, it is important to rerun the bid summary and/or spread. The Run Bid 
Summary and Run Spread buttons are bolded when a rerun is required.
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Standard Markup in Bid Summary

 ƒ The Cost Basis, Markup %, and Markup amounts are displayed for each type of cost and for the entire job.
 ƒ You can change the Markup % as necessary.

Standard Spreads in Bid Summary

 ƒ Spread instructions specify how to distribute indirect, markup, and addon/bond costs.
 ƒ Summarizing and spreading determines the “balanced” prices for the bid.
 ƒ These defaults can be overridden in the Spread Overrides tab. Biditems that do not have their spread instructions 

overridden follow the instructions set here with the remaining dollars.

For details and examples of each standard spread option, press F1 to open HeavyBid help and search for “Standard 
Spreads” on the Index tab.

Notes
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Addons Tab in Bid Summary

 ƒ Addons are used to add miscellaneous cost or markup to the bid based upon all or part of the dollars in the 
estimate. Click the Basis >> column header to specify the basis for the addon.

 ƒ To record the addon as cost for reporting purposes, select the Cost check box; otherwise, the additional dollars are 
recorded as markup.

Notes
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Bond Tab in Bid Summary

Use the Bond tab to do the following:
 ƒ 7R�FUHDWH�D�QHZ�ERQG�WDEOH��HQWHU�WKH�QDPH�LQ�WKH�7DEOH�¿�HOG�DQG�SURYLGH�ERQG�WDEOH�LQIRUPDWLRQ�
 ƒ 7R�YLHZ�RU�PRGLI\�DQ�H[LVWLQJ�ERQG�WDEOH��HQWHU�WKH�QDPH�LQ�WKH�7DEOH�¿�HOG�RU�FOLFN�WKH�  selection button to pull 

from a list. Modify the description and Bond Table information as necessary.
 ƒ ,Q�WKH�6HOHFWHG�%RQG�7DEOH�¿�HOG��FOLFN�WKH�  selection button to choose a table. Your selection will also appear at 

the bottom-left of the Totals tab.
 ƒ 7R�VSUHDG�WKH�ERQG�WR�D�VLQJOH�ELGLWHP��VHOHFW�WKH�ELGLWHP�LQ�WKH�%RQG�,WHP�¿�HOG�

dŚĞ�ďŽŶĚ�ƚĂďůĞ�ĚŝƐƉůĂǇĞĚ�ŝŶ�ƚŚĞ��ŽŶĚ�ƚĂď�ŵĂǇ�ŶŽƚ�ďĞ�ƚŚĞ�ƐĞůĞĐƚĞĚ�ďŽŶĚ�ƚĂďůĞ͖�ƌĂƚŚĞƌ͕ �ŝƚ�ŝƐ�ƚŚĞ�ĐƵƌƌĞŶƚ�ďŽŶĚ�ƚĂďůĞ�ƚŚĂƚ�ŝƐ�
ŽƉĞŶ�ĨŽƌ�ĞĚŝƟ�ŶŐ͘

Notes
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Bid Pricing
^ƵŵŵĂƌǇ�ƚĂď�х�WƌŝĐŝŶŐ

After summarizing the estimate in Bid Summary, HeavyBid takes the totals and provides a place to make 
¿�QDO�FKDQJHV�WR�WKH�ELG�SULFHV�LQ�WKH�%LG�3ULFLQJ�6FUHHQ��$FFHVV�WKLV�VFUHHQ�E\�VHOHFWLQJ�6XPPDU\�WDE�!�
Pricing or by clicking the Bid Pricing icon on the tool bar. 

Here, an estimator can review and change bid prices, make last minute adjustments, review statistics of the estimate, 
and much more. The dollars spread by the bid summary process can be changed and re-spread manually in this screen 
per the estimator’s liking. 

Bid Pricing Status Types

The status column indicates the current bid pricing status for each biditem. The different status types are as follows:
Unbalanced (U):  The bid price is different than the system-generated balanced price.
Frozen (F):   The price is “frozen” and cannot be changed. Freeze by entering “F” in the Status column, or 

unfreeze by deleting the “F”. You can also click the Freeze button to freeze and unfreeze items.
Closing Account (C):  The biditem is a closing account and can receive adjustment amounts. Set a biditem to a 

closing account by entering “C” in the Status column or by clicking the Closing button.
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Rounding Routine

To automatically round your prices (e.g., to the nearest dollar), use the Rounding Routine. Access this option by 
clicking Options link > Rounding Routine.

�ĚĚŝƟ�ŽŶĂů�/ŶĨŽƌŵĂƟ�ŽŶ�ŽŶ��ŝĚ�WƌŝĐŝŶŐ

 ƒ %H�VXUH�WR�UXQ�D�¿�QDO�VXPPDU\�DQG�VSUHDG�before working with prices. This can be done from this screen by 
clicking the 
%H�VXUH�WR�UXQ�D�¿�QDO�VXPPDU\�DQG�VSUHDG�

 Summary button.
 ƒ Note that the Balanced Total and Bid Total may not match due to rounding to the nearest cent in the Bid Pricing 

screen. You can rectify the difference manually or by clicking the Closing Account Routine link. Running the 
Closing Account Routine several times may result in getting closer and closer to the Balanced Total.

 ƒ You can return to a Balanced Bid by selecting Options link > Restore to Balanced Bid.

Notes
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Reviewing the Estimate
Once the cost entry portion of building the estimate is complete, it is important to review the estimate to verify the 
data in the estimate. This can be performed in multiple ways, including the use of exhaustive reports and checks. One 
detailed area of review is the Estimate Review screen.

Estimate Review
YƵĞƌǇ�ƚĂď�х��ƐƟ�ŵĂƚĞ

The Estimate Review screen provides many different checks on different levels throughout HeavyBid. 
Biditems, activities, and resources are all examined in detail to provide you with the most accurate and 
EHQH¿�FLDO�LQIRUPDWLRQ��

By default, HeavyBid�DOHUWV�\RX�WR�LWHPV�WKDW�PD\�EH�D�SUREOHP�E\�KLJKOLJKWLQJ�WKH�UHVSHFWLYH�¿�HOG�ZLWK�D�\HOORZ�
background. This does not always indicate a problem, but indicates an item that is worth investigating to make sure 
the estimate contains the data you need.

To view the details of any indicator on the Estimate Review screen, do the following:
1. Click the  selection button next to the indicator to view a list of items and their locations in the estimate. 
2. On the list, click the Create CheckList and Review Items button. This creates a checklist to analyze the details 

within the Estimate Entry – Tree View. You can cycle through the list using the  Next button on the toolbar.
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�ĚĚŝƟŽŶĂů�/ŶĨŽƌŵĂƟŽŶ�ŽŶ��ƐƟŵĂƚĞ�ZĞǀŝĞǁ

 ƒ 7KLV�VFUHHQ�SURYLGHV�D�GHWDLOHG�DQDO\VLV�RI�WKH�HVWLPDWH�WR�KHOS�\RX�¿QG�DQG�FRUUHFW�SRWHQWLDO�SUREOHPV�RU�
mistakes. Each tab has information pertinent to the tab heading.

 ƒ Potential problems are highlighted in yellow. Note that these are not always errors, but simply potential problems.
 ƒ This is a powerful feature of HeavyBid, and is an important tool to run when completing a bid.

Notes
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Reports
ZĞƉŽƌƚƐ�ƚĂď

HeavyBid provides many reports based on cost data, price data, estimate setup information, or all of these 
items together. Versatile reporting options give you the ability to view the information that helps you 
estimate more precisely. Most reports can be accessed on the Reports tab.

HeavyBid reports are grouped as follows:

 ƒ Cost Reports
 ƒ Summary Reports
 ƒ Quote System Reports

 ƒ Cash Flow Reports
 ƒ Vendor/Business Contact Reports
 ƒ Estimate Resource Reports

 ƒ System Resource Reports

Examples of two major reports are shown here.

Bid Pricing Report
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Direct Cost Report
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Bid Proposal
^ƵŵŵĂƌǇ�ƚĂď�х��ŝĚ�WƌŽƉŽƐĂůƐ�ŐƌŽƵƉ

7KH�¿QDO�VWHS�LV�WR�FUHDWH�D�ELG�SURSRVDO�IRU�WKH�RZQHU��7KHVH�RSWLRQV�FDQ�EH�IRXQG�LQ�WKH�6XPPDU\�WDE�!�%LG�
Proposals group. Here, you can select a Concise, Customized, or Word bid proposal (Advanced and Comprehensive 
systems). These proposals include the biditems, units, and unit prices for your bid, and can be sent to the owner.

Example of the Concise Bid Proposal:

Notes
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APPENDIX

Quick Reference Guide

Most Commonly Used Navigation 
Techniques

Scan Records
 ƒ Click arrow icons on tool bar

 ƒ Click arrows at edges of tables

 ƒ Press CTRL+END and CTRL+HOME keys

 ƒ Press PAGE UP and PAGE DOWN keys

 ƒ Press F7 and F8 keys

 ƒ Presss UP ARROW and DOWN ARROW keys

View Selection Lists
 ƒ �ůŝĐŬ�ƐĞůĞĐƟŽŶ�ďƵƩŽŶ�ŝŶ�Ă�ĚĂƚĂ�ĮĞůĚ

 ƒ WƌĞƐƐ�&ϰ�ŬĞǇ�ǁŚŝůĞ�ĐƵƌƐŽƌ�ŝƐ�ŝŶ�Ă�ĮĞůĚ�ƚŚĂƚ�ŚĂƐ�Ă�ƐĞůĞĐƟŽŶ�ďƵƩŽŶ

Save Records
 ƒ Click disk icon on tool bar

 ƒ Press CTRL+S keys

 ƒ Press F2 key

Delete Records
 ƒ Click [X] delete icon on tool bar

 ƒ Press CTRL+D keys

 ƒ Press SHIFT+F2 keys

View Help
 ƒ Press F1 key

 ƒ Select HELP tab > HeavyBid Help F1

Exit
 ƒ �ůŝĐŬ�΀y΁�ĐůŽƐĞ�ďƵƩŽŶ�Ăƚ�ƚŽƉͲƌŝŐŚƚ�ŽĨ�ǁŝŶĚŽǁ

 ƒ Press ESC key

 ƒ �ůŝĐŬ��ĂŶĐĞů�ďƵƩŽŶ�;ǁŚĞƌĞ�ĂǀĂŝůĂďůĞͿ

Cost Entry

Estimate Tab (ALT+T)
 ƒ dƌĞĞ�sŝĞǁ͗��ŶƚĞƌ�ĐŽƐƚƐ�ŝŶ�ĂŶ�ĞĂƐǇͲƚŽͲƌĞĂĚ�ǀŝĞǁ�ƚŚĂƚ�ĚŝƐƉůĂǇƐ�ƚŚĞ�ĞƐƟŵĂƚĞ�
ŝŶ�Ă�ƚƌĞĞ�ĨŽƌŵĂƚ͘

 ƒ ^ƉƌĞĂĚƐŚĞĞƚ�sŝĞǁ͗��ŶƚĞƌ�ĂĐƟǀŝƟĞƐ�ŝŶ�Ă�ƐƉƌĞĂĚƐŚĞĞƚ�ĨŽƌŵĂƚ�;ƉĂƌƟĐƵůĂƌůǇ�
ĞǆĐĞůůĞŶƚ�ĨŽƌ�ĐŚĂŶŐŝŶŐ�ĐƌĞǁ�ƉƌŽĚƵĐƟŽŶƐͿ͘

 ƒ ^ŝŶŐůĞ�sŝĞǁ͗��ŶƚĞƌ�ĐŽƐƚƐ�ŝŶƚŽ�ƚŚĞ�ĞƐƟŵĂƚĞ͕�ŽŶĞ�ĂĐƟǀŝƚǇ�Ăƚ�Ă�ƟŵĞ͘

 ƒ YƵŝĐŬ�^ƵďͬDĂƚĞƌŝĂů��ŶƚƌǇ͗�;KƉƟŽŶĂůͿ��ŶƚĞƌ�ĂŶĚ�ĂŶĂůǇǌĞ�Ă�ůĂƌŐĞ�ŶƵŵďĞƌ�ŽĨ�
ƐƵďĐŽŶƚƌĂĐƚ�Žƌ�ŵĂƚĞƌŝĂů�ŝƚĞŵƐ͘

 ƒ �ŽƉǇ��ŝĚŝƚĞŵƐͬ�ĐƟǀŝƟĞƐ͗��ŽƉǇ�ŝƚĞŵƐ�ǁŝƚŚŝŶ�ĂŶĚ�ĂŵŽŶŐ�ĞƐƟŵĂƚĞƐ͘

 ƒ ^ƉƌĞĂĚƐŚĞĞƚ�>ŝŶŬƐ͗�;KƉƟŽŶĂůͿ�>ŝŶŬ�ĐŽƐƚƐ�ĂŶĚ�ƋƵĂŶƟƟĞƐ�ƚŽ�ƐƉƌĞĂĚƐŚĞĞƚƐ͘

Cost Editing

Edit Tab (ALT+E) > Change Estimate Data
 ƒ �ŚĂŶŐĞ��ŝĚŝƚĞŵ��ĂƚĂ͗��ŚĂŶŐĞ�ƐĞůĞĐƚĞĚ�ĚĂƚĂ�ŝŶ�ƐĞůĞĐƚĞĚ�ďŝĚŝƚĞŵƐ͘

 ƒ �ŚĂŶŐĞ��ĐƟǀŝƚǇ��ĂƚĂ͗��ŚĂŶŐĞ�ƐĞůĞĐƚĞĚ�ĚĂƚĂ�ŝŶ�ƐĞůĞĐƚĞĚ�ĂĐƟǀŝƟĞƐ͘

 ƒ �ŚĂŶŐĞ�DĂƚĞƌŝĂůͬKƚŚĞƌ�ZĞƐŽƵƌĐĞ��ŽƐƚƐ͗�ZĞǀŝĞǁ�ĂŶĚ�ĐŚĂŶŐĞ�ƌĞƐŽƵƌĐĞƐ�
ƚŚƌŽƵŐŚŽƵƚ�ƚŚĞ�ĞƐƟŵĂƚĞ͘

 ƒ �ŚĂŶŐĞ�^ĂůĞƐ�dĂǆ�ͬ��ƐĐĂůĂƟŽŶ͗��ŚĂŶŐĞ�ƚĂǆĞƐ�ĂŶĚ�ĞƐĐĂůĂƟŽŶ�ƚŚƌŽƵŐŚŽƵƚ�
ƚŚĞ�ĞƐƟŵĂƚĞ͘

Setup Tab (ALT+S)
�ŌĞƌ�ĐŚĂŶŐŝŶŐ�ĂŶǇ�ŝƚĞŵ�ƚŚĂƚ�ŚĂƐ�ďĞĞŶ�ƵƐĞĚ�ŝŶ�ƚŚĞ�ĞƐƟŵĂƚĞ͕�ƚŚĞ�ĞƐƟŵĂƚĞ�
ĐĂŶ�ďĞ�ƵƉĚĂƚĞĚ�ǁŝƚŚ�ƚŚĞ�ŶĞǁ�ƌĂƚĞ͘

Typical Steps in Creating an Estimate

A. One-Time Setup
ϭ͘� ^ĞůĞĐƚ�ƚŚĞ�Ͱ�^dD�^d�ĞƐƟŵĂƚĞ�;DĂƐƚĞƌ��ƐƟŵĂƚĞͿ͘

Ϯ͘� ^Ğƚ�ƵƉ�ŽǀĞƌƟŵĞ�ƌƵůĞƐ͘

ϯ͘� ^Ğƚ�ƵƉ�ĐĂůĞŶĚĂƌƐ͘

ϰ͘� ^Ğƚ�ƵƉ�ǁŽƌŬĞƌ Ɛ͛�ĐŽŵƉ�ƌĂƚĞƐ͘

ϱ͘� ^Ğƚ�ƵƉ�ƚǇƉŝĐĂů�ůĂďŽƌ�ĐƌĂŌƐ͘

ϲ͘� ^Ğƚ�ƵƉ�ƚǇƉŝĐĂů�ĞƋƵŝƉŵĞŶƚ͘

ϳ͘� ^Ğƚ�ƵƉ�ƚǇƉŝĐĂů�ĐƌĞǁƐ͘

ϴ͘� ^Ğƚ�ƵƉ�ƚǇƉŝĐĂů�ŵĂƌŬƵƉ�й͕�ĂĚĚŽŶƐ͕�ĂŶĚ�ďŽŶĚ�ƚĂďůĞƐ�;ŽŶ��ŝĚ�^ƵŵŵĂƌǇ�
ƐĐƌĞĞŶͿ͘

ϵ͘� ^Ğƚ�ƵƉ�ĚĞĨĂƵůƚ��ƐƟŵĂƚĞ�/ŶĨŽƌŵĂƟŽŶ��ĂƚĂ͕�ŝŶĐůƵĚŝŶŐ�^ĂůĞƐ�dĂǆ͕�����
ĐŽĚĞƐ͕�ĂŶĚ�ĚĞĨĂƵůƚ�ǀĂůƵĞƐ�;Ğ͘Ő͕͘�ĐĂůĞŶĚĂƌƐ͕�ǁŽƌŬ�ƌƵůĞƐͿ͘

B. Create Estimate
ϭ͘� ^ĞůĞĐƚ�&ŝůĞ�ƚĂď�х�EĞǁ�х�EĞǁ��ƐƟŵĂƚĞ͘

Ϯ͘� �ŶƚĞƌ�ĂŶ��ƐƟŵĂƚĞ��ŽĚĞ͕�ĂŶĚ�ƚŚĞŶ�ĐůŝĐŬ�EĞǆƚ͘

ϯ͘� �ŶƚĞƌ�ƚŚĞ��ƐƟŵĂƚĞ�EĂŵĞ͕�ĂŶĚ�ƚŚĞŶ�ĐůŝĐŬ�EĞǆƚ͘

ϰ͘� ^ĞůĞĐƚ�Ͱ�^dD�^d�ĂƐ�^ŽƵƌĐĞ��ƐƟŵĂƚĞ�;Žƌ�ƐĞůĞĐƚ�ĂŶŽƚŚĞƌ�ĞƐƟŵĂƚĞͿ͕�
ĂŶĚ�ƚŚĞŶ�ĐůŝĐŬ�&ŝŶŝƐŚ͘

C. Modify Resources
ϭ͘� �ŚĂŶŐĞ�ĂŶǇ�ĞƐƟŵĂƚĞ�ǀĂůƵĞ�;Ğ͘Ő͕͘�ƚĂǆ�ƌĂƚĞƐ͕�ďŽŶĚ�ƚĂďůĞƐͿ͘

Ϯ͘� DŽĚŝĨǇ�ĂŶǇ�ƌĞƐŽƵƌĐĞ�;Ğ͘Ő͕͘�ůĂďŽƌ͕ �ĞƋƵŝƉŵĞŶƚ͕�ĐƌĞǁƐ͕�ŵĂƚĞƌŝĂůƐͿ͘

ϯ͘� ^Ğƚ�ƵƉ��ŝĚŝƚĞŵƐ�;Žƌ�ĞƋƵŝǀĂůĞŶƚͿ͘
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D. Enter Estimate
ϭ͘� hƐĞ�ŽƉƟŽŶƐ�ŽŶ��ƐƟŵĂƚĞ�ƚĂď�ƚŽ�ĞŶƚĞƌ�ĂĐƟǀŝƟĞƐ͕�ĐƌĞǁƐ͕�ĂŶĚ�ĐŽƐƚ�

ƌĞƐŽƵƌĐĞƐ�ŝŶƚŽ�ƚŚĞ�ĞƐƟŵĂƚĞ͘

Ϯ͘� hƐĞ�ŽƉƟŽŶƐ�ŽŶ�YƵĞƌǇ�ƚĂď�ƚŽ�ĐŚĞĐŬ�ǇŽƵƌ�ǁŽƌŬ�ǁŝƚŚ��ŝĚŝƚĞŵƐ͕�
�ĐƟǀŝƟĞƐ͕�ĞƚĐ͘

E. Print Estimate
^ĞůĞĐƚ�ZĞƉŽƌƚƐ�ƚĂď�х��ŽƐƚ�ZĞƉŽƌƚ�ƚŽ�ƉƌŝŶƚ�Ă�ĐŽƉǇ�ŽĨ�ƚŚĞ�ĞƐƟŵĂƚĞ͘

F. Summarize Estimate
ϭ͘� ^ĞůĞĐƚ�^ƵŵŵĂƌǇ�ƚĂď�х�^ƵŵŵĂƌǇ�ƚŽ�ŽƉĞŶ�ƚŚĞ��ŝĚ�^ƵŵŵĂƌǇ�ǁŝŶĚŽǁ͘

Ϯ͘� �ůŝĐŬ�ƚŚĞ�ZƵŶ��ŝĚ�^ƵŵŵĂƌǇ�ĂŶĚ�ZƵŶ�^ƉƌĞĂĚ�ďƵƩŽŶƐ�ŝĨ�ƚŚĞǇ�ĂƌĞ�
ďŽůĚĞĚ͘

G. Add Markup, etc.
ϭ͘� ^ƉĞĐŝĨǇ�Žƌ�ĐŚĂŶŐĞ�ƚŚĞ�ŵĂƌŬƵƉ�ƉĞƌĐĞŶƚĂŐĞ͘

Ϯ͘� �ĚĚ�Žƌ�ĐŚĂŶŐĞ�ĂĚĚŽŶƐ�ĂƐ�ŶĞĐĞƐƐĂƌǇ͘

ϯ͘� �ŶƐƵƌĞ��ŽŶĚ�ŚĂƐ�ďĞĞŶ�ƐĞƚ�ƵƉ�ĂŶĚ�ƐĞůĞĐƚĞĚ�ŝĨ�ĚĞƐŝƌĞĚ

ϰ͘� ^ƉĞĐŝĨǇ�^ƉƌĞĂĚ�KǀĞƌƌŝĚĞƐ�ƚŽ�ƐĞƚ�ƵƉ�ĂůƚĞƌŶĂƚĞ�DĂƌŬƵƉ͕�/ŶĚŝƌĞĐƚ͕�ĂŶĚͬ
Žƌ��ĚĚŽŶͬ�ŽŶĚ͘

H. Compute Bid
/Ĩ�ďŽůĚĞĚ͕�ĐůŝĐŬ�ZƵŶ�^ƉƌĞĂĚ�ďƵƩŽŶ�ƚŽ�ƐƉƌĞĂĚ�Ăůů�DĂƌŬƵƉ͕�/ŶĚŝƌĞĐƚƐ͕�ĞƚĐ͕͘�
ĂŶĚ�ƚŽ�ŐĞŶĞƌĂƚĞ�ƚŚĞ�ďĂůĂŶĐĞĚ�ďŝĚ�ƉƌŝĐĞƐ͘

I. Print Summary Reports
^ĞůĞĐƚ�^ƵŵŵĂƌǇ�ƚĂď�х�^ƵŵŵĂƌǇ�ZĞƉŽƌƚƐ�ƚŽ�ƉƌŝŶƚ��ŝĚ�^ƵŵŵĂƌǇ�ZĞƉŽƌƚƐ�
ŝĨ�ĚĞƐŝƌĞĚ͘

J. Review Bid Pricing
^ĞůĞĐƚ�^ƵŵŵĂƌǇ�ƚĂď�х�WƌŝĐŝŶŐ�ƚŽ�ŵŽĚŝĨǇ�ďŝĚ�ƉƌŝĐĞƐ�ŝĨ�ĚĞƐŝƌĞĚ͘�dŚĞ��ŝĚ�
dŽƚĂů�ŝƐ�ŚŝŐŚůŝŐŚƚĞĚ�ŝŶ�ǇĞůůŽǁ͘

K. Make Changes
ϭ͘� DĂŬĞ�ĐŚĂŶŐĞƐ�ƚŽ�ĐŽƐƚ�ƌĞƐŽƵƌĐĞƐ�ĂƐ�ďĞƩĞƌ�ƉƌŝĐĞƐ�ĐŽŵĞ�ŝŶ͘

Ϯ͘� hƐĞ�ƚŚĞ��Ěŝƚ�ƚĂď�ƚŽ�ĂĐĐĞƐƐ�ƐƉĞĐŝĂů�ĐŚĂŶŐĞ�ƌŽƵƟŶĞƐ͘

ϯ͘� �ŌĞƌ�ĂŶǇ�ĐŚĂŶŐĞƐ�ƚŽ�ĐŽƐƚ͕�ƌĞƚƵƌŶ�ƚŽ�͞^ƵŵŵĂƌŝǌĞ��ƐƟŵĂƚĞ͟�ƐƚĞƉ�ĂŶĚ�
ƌĞƉĞĂƚ�ƌĞŵĂŝŶŝŶŐ�ƐƚĞƉƐ�ĂƐ�ŶĞĐĞƐƐĂƌǇ͘

L. Review Estimate
�ůǁĂǇƐ�ƌĞǀŝĞǁ�ǇŽƵƌ�ĞƐƟŵĂƚĞ�;YƵĞƌǇ�ƚĂď�х��ƐƟŵĂƚĞͿ͘�dŚĞ��ƐƟŵĂƚĞ�
ZĞǀŝĞǁ�ůŝƐƚƐ�ŽǀĞƌ�ϲϬ�ŝŶĨŽƌŵĂƟŽŶ�ĂďŽƵƚ�ƚŚĞ�ĞƐƟŵĂƚĞ�ƚŚĂƚ�ŵĂǇ�ŚĞůƉ�ǇŽƵ�
ĂǀŽŝĚ�ĂŶ�ĞƌƌŽƌ͘

Cursor Movement

Mouse
 ƒ ^ĞůĞĐƚ�ƚĂďƐ�ĂŶĚ�ŵĞŶƵ�ŽƉƟŽŶƐ

 ƒ �ůŝĐŬ�ŝĐŽŶƐ�ĂŶĚ�ďƵƩŽŶƐ

 ƒ �ůŝĐŬ�ŝŶ�Ă�ĮĞůĚ�ƚŽ�ŵŽǀĞ�ĐƵƌƐŽƌ�ƚŚĞƌĞ

Function Keys
F1  Open help

F2  Save

F4  KƉĞŶ�ƐĞůĞĐƟŽŶ�ůŝƐƚ�ĨŽƌ�ĐƵƌƌĞŶƚ�ĮĞůĚ�;ǁŚĞƌĞ�ĂƉƉůŝĐĂďůĞͿ

F5  �ůĞĂƌ�ĮĞůĚƐ�ŽŶ�ƐĐƌĞĞŶ

F6  DŽǀĞ�ĐƵƌƐŽƌ�ƚŽ�ŶĞǆƚ�ĮĞůĚ

F7  &ŝŶĚ�ƉƌĞǀŝŽƵƐ�ƌĞĐŽƌĚ

F8  Find next record

F11  /ŶƐĞƌƚ�ŶĞǁ�ƌŽǁ�ŝŶ�ƚĂďůĞ�;ŐƌŝĚͿ

ALT Keys
WƌĞƐƐ�ĂŶĚ�ŚŽůĚ�ƚŚĞ��>d�ŬĞǇ͕ �ĂŶĚ�ƚŚĞŶ�ƉƌĞƐƐ�ƚŚĞ�ƵŶĚĞƌůŝŶĞĚ�ůĞƩĞƌ�ŝŶ�Ă�ǁŽƌĚ�ƚŽ�
ƉĞƌĨŽƌŵ�ƚŚĂƚ�ĨƵŶĐƟŽŶ͘�zŽƵ�ĐĂŶ�ĂůƐŽ�ƵƐĞ��>d�ŬĞǇƐ�ƚŽ�ŽƉĞŶ�ƚŚĞ�ŵĞŶƵ�ƚĂďƐ͗

ALT+F File tab

ALT+E Edit tab

ALT+S ^ĞƚƵƉ�ƚĂď

ALT+T �ƐƟŵĂƚĞ�ƚĂď

ALT+Q YƵĞƌǇ�ƚĂď

ALT+R Reports tab

ALT+U ^ƵŵŵĂƌǇ�ƚĂď

ALT+Y� ^ƵďƐǇƐƚĞŵƐ�ƚĂď

ALT+O Tools tab

ALT+H Help tab

ALT+F4� ;�ǆŝƚ�HeavyBidͿ

CTRL Keys
CTRL+A Insert a new line in tables

CTRL+C Copy data to clipboard

CTRL+D �ĞůĞƚĞ�ĐƵƌƌĞŶƚ�ƌĞĐŽƌĚ

CTRL+O KƉĞŶ�ĞƐƟŵĂƚĞ

CTRL+P Print report

CTRL+N EĞǁ�ĞƐƟŵĂƚĞ

CTRL+R Abandon changes rather than saving

CTRL+S ^ĂǀĞ�ĐƵƌƌĞŶƚ�ƌĞĐŽƌĚ

CTRL+V WĂƐƚĞ�ĐŽƉŝĞĚͬĐƵƚ�ĚĂƚĂ�ĨƌŽŵ�ĐůŝƉďŽĂƌĚ�ƚŽ�ƚŚĞ�ĐƵƌƐŽƌ�ůŽĐĂƟŽŶ

CTRL+X �Ƶƚ�ĚĂƚĂ�ƚŽ�ĐůŝƉďŽĂƌĚ

CTRL+Z �ůĞĂƌ�ĮĞůĚ

CTRL+END Find last record

CTRL+HOME &ŝŶĚ�ĮƌƐƚ�ƌĞĐŽƌĚ

CTRL+F4 �ƐĐĂƉĞ�ĨƌŽŵ�ĐƵƌƌĞŶƚ�ƐĐƌĞĞŶ

CTRL+F6 DŽǀĞ�ĨƌŽŵ�ƐĐƌĞĞŶ�ƚŽ�ƐĐƌĞĞŶ

Other Keys
TAB�� DŽǀĞ�ĐƵƌƐŽƌ�ƚŽ�ŶĞǆƚ�ĮĞůĚ

SHIFT+TAB�� DŽǀĞ�ĐƵƌƐŽƌ�ƚŽ�ƉƌĞǀŝŽƵƐ�ĮĞůĚ

ENTER�� DŽǀĞ�ĐƵƌƐŽƌ�ƚŽ�ŶĞǆƚ�ĮĞůĚ�;ĞǆĐĞƉƟŽŶ͗�ŝĨ�Ă�ďƵƩŽŶ�ŝƐ�ŚŝŐŚůŝŐŚƚĞĚ͕�
ŝƚ�ĞǆĞĐƵƚĞƐ�ƚŚĞ�ďƵƩŽŶ�ůŝŬĞ�Ă�ŵŽƵƐĞĐůŝĐŬͿ

ESC  �ǆŝƚ�ĐƵƌƌĞŶƚ�ƐĐƌĞĞŶ

PAGE UP  Scan table backwards

PAGE DOWN Scan table forwards

UP ARROW DŽǀĞ�ƵƉ�ŽŶĞ�ůŝŶĞ�ŝŶ�ƚĂďůĞƐ

DOWN ARROW Move down one line in tables
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Code Structure
HeavyBid�ƵƐĞƐ�Ă�ĐŽƐƚ�ĐŽĚĞ�ƐƚƌƵĐƚƵƌĞ�ƚŚĂƚ�ĂůůŽǁƐ�ĞĂĐŚ�ĐŽƐƚ�ƌĞƐŽƵƌĐĞ�ƚŽ�ďĞ�
ŝĚĞŶƟĮĞĚ�ďǇ�Ă�ƵŶŝƋƵĞ�ĐŽĚĞ͗

BIDITEM + ACTIVITY + RESOURCE

Biditem
dŚĞ�ĐŽĚĞ�ĨŽƌ�Ă�ŐƌŽƵƉ�ŽĨ�ĐŽƐƚƐ͘�dŚĞ�ĐŽĚĞ�ŝƐ�ϭϬ�ĚŝŐŝƚƐ�ĂŶĚ�ǁĞ�ƌĞĐŽŵŵĞŶĚ�ŝƚ�ďĞ�
ƚŚĞ�ƐĞƋƵĞŶƟĂů�ŝƚĞŵ�ŶƵŵďĞƌ�ƟŵĞƐ�ϭϬ�Žƌ�ϭϬϬ͘���ƐĞƉĂƌĂƚĞ�Ϯϴ�ĐŚĂƌĂĐƚĞƌ�ĮĞůĚ�ŝƐ�
ĂǀĂŝůĂďůĞ�ĨŽƌ�ƚŚĞ�ŽǁŶĞƌ Ɛ͛�ĐŽĚĞ�ŶƵŵďĞƌ͘

Biditem Codebook

��ĚĂƚĂďĂƐĞ�ŽĨ�ƐƚĂƚĞ�ĐŽĚĞƐ�ĂŶĚ�ĚĞƐĐƌŝƉƟŽŶƐ�ƚŽ�ƋƵŝĐŬůǇ�ƐĞƚ�ƵƉ�ďŝĚ�ŝƚĞŵƐ�ĨŽƌ�
ƐƚĂƚĞ�ǁŽƌŬ͖�ŝƚ�ĐĂŶ�ĂůƐŽ�ďĞ�ƵƐĞĚ�ĨŽƌ�ƉƌŝǀĂƚĞ�ǁŽƌŬ͘

Biditem Types

͞�͟� �ŝƌĞĐƚ�ĐŽƐƚ�ĐĂƚĞŐŽƌǇ͘

͞/͟� /ŶĚŝƌĞĐƚ�ĐŽƐƚ�ĐĂƚĞŐŽƌǇ͘��ůů�ĐŽƐƚƐ�ŚĞƌĞ�ŵƵƐƚ�ĞǀĞŶƚƵĂůůǇ�ďĞ�ƐƉƌĞĂĚ�ƚŽ�ƚŚĞ�
�ŝƌĞĐƚ�ĐŽƐƚ�ĐĂƚĞŐŽƌŝĞƐ͘

͞E͟� EŽŶͲĂĚĚŝƟǀĞ�ŝƚĞŵƐ�ǁŚŝĐŚ�ĚŽ�ŶŽƚ�ĂĚĚ�ŝŶƚŽ�ƚŚĞ�ĞƐƟŵĂƚĞ�ƚŽƚĂůƐ͘�dŚĞƐĞ�
ĂƌĞ�ƚǇƉŝĐĂůůǇ�ƵƐĞĚ�ĂƐ�ĂůƚĞƌŶĂƚĞƐ�Žƌ�ĐŽƐƚ�ǁŽƌŬƵƉƐ�ǇŽƵ�ĚŽ�ŶŽƚ�ǁĂŶƚ�ƚŽ�
ĚĞůĞƚĞ͘

͞,͟� ,ŽůĚŝŶŐ��ĐĐŽƵŶƚ͘��ŽƐƚƐ�ŝŶ�ƚŚŝƐ�ďŝĚŝƚĞŵ�ĂƌĞ�ƐƉƌĞĂĚ�ƚŽ�ŽƚŚĞƌ�ďŝĚŝƚĞŵƐ�ŝŶ�
ƚŚĞ�ĞƐƟŵĂƚĞ͕�ƚŚƌŽƵŐŚ�,ŽůĚŝŶŐ��ĐĐŽƵŶƚ��ŶƚƌǇ͘� 
�ǀĂŝůĂďůĞ�ŝŶ��ĚǀĂŶĐĞĚ�ĂŶĚ��ŽŵƉƌĞŚĞŶƐŝǀĞ�ƐǇƐƚĞŵƐ͘

͞�͟� �ƋƵŝƉŵĞŶƚ��ĐĐŽƵŶƚ͘��ŽƐƚƐ�ŝŶ�ƚŚŝƐ�ďŝĚŝƚĞŵ�ĂƌĞ�ƵƐĞĚ�ƚŽ�ĐĂůĐƵůĂƚĞ�ƚŚĞ�
ƌĞŶƚĂů�ƌĂƚĞ�ĨŽƌ�Ă�ƉŝĞĐĞ�ŽĨ�ĞƋƵŝƉŵĞŶƚ�ŝŶ��ƋƵŝƉŵĞŶƚ�^ĞƚƵƉ͘� 
�ǀĂŝůĂďůĞ�ŝŶ��ŽŵƉƌĞŚĞŶƐŝǀĞ�ƐǇƐƚĞŵƐ͘

zŽƵ�ĐĂŶ�ĐŚĂŶŐĞ�ƚŚĞ�ŝƚĞŵƐ�ĨƌŽŵ�ŽŶĞ�ĐŽƐƚ�ƚǇƉĞ�ƚŽ�ĂŶŽƚŚĞƌ�Ăƚ�ĂŶǇ�ƟŵĞ͘

Activity 
��ƚĂƐŬ�ƚŚĂƚ�ŝƐ�ƉĞƌĨŽƌŵĞĚ�ǁŝƚŚŝŶ�Ă�ďŝĚŝƚĞŵ͘�zŽƵ�ĐĂŶ�ƚŚŝŶŬ�ŽĨ�ŝƚ�ĂƐ�Ă�ǀĞƌď͕�
ƐƵĐŚ�ĂƐ�͞�ƌŝǀĞ�WŝůĞƐ͟�Žƌ�͞�ƵǇ�^ƚƌƵĐƚƵƌĂů�^ƚĞĞů͘͟ ��ĐƟǀŝƚǇ�ĐŽĚĞƐ�ĐĂŶ�ďĞ�ƵƉ�ƚŽ�
ϭϮ�ĐŚĂƌĂĐƚĞƌƐ͕�ďƵƚ�ǁĞ�ĚŽ�ŶŽƚ�ƌĞĐŽŵŵĞŶĚ�ƵƐŝŶŐ�ƚŚĂƚ�ŵĂŶǇ͘�dŚĞƌĞ�ĐĂŶ�ďĞ�ĂƐ�
ŵĂŶǇ�ĂĐƟǀŝƟĞƐ�ŝŶ�Ă�ďŝĚŝƚĞŵ�ĂƐ�ŶĞĐĞƐƐĂƌǇ͘

Activity Codebook 

��ƐƚĂŶĚĂƌĚŝǌĞĚ�ĂĐƟǀŝƚǇ�ƐƚƌƵĐƚƵƌĞ�ƚŚĂƚ�ĐĂŶ�ďĞ�ĐƵƐƚŽŵŝǌĞĚ�ƚŽ�ĂŶǇ�ƚǇƉĞ�ŽĨ�
ǁŽƌŬ͘��ŶĂďůĞƐ�ǇŽƵ�ƚŽ�ƐƚĂŶĚĂƌĚŝǌĞ�ǇŽƵƌ�ĂĐƟǀŝƟĞƐ�ĂŶĚ�ŽīĞƌƐ�ŵĂŶǇ�ĂĚĚŝƟŽŶĂů�
ĨĞĂƚƵƌĞƐ�ƚŽ�ĂƵƚŽŵĂƚĞ�ǇŽƵƌ�ĞƐƟŵĂƟŶŐ͘

Resource 
dŚĞ�ĐŽƐƚ�ƌĞƐŽƵƌĐĞƐ�ƌĞƋƵŝƌĞĚ�ĨŽƌ�ĂŶ�ĂĐƟǀŝƚǇ͘�ZĞƐŽƵƌĐĞ�ĐŽĚĞƐ�ĐĂŶ�ďĞ�ƵƉ�ƚŽ�
ϭϮ�ĐŚĂƌĂĐƚĞƌƐ͕�ďƵƚ�ǁĞ�ƌĞĐŽŵŵĞŶĚ�ǇŽƵ�ƵƐĞ�ϲ�Žƌ�ůĞƐƐ͘�dŚĞƌĞ�ĐĂŶ�ďĞ�ĂƐ�ŵĂŶǇ�
ƌĞƐŽƵƌĐĞƐ�ŝŶ�ĂŶ�ĂĐƟǀŝƚǇ�ĂƐ�ŶĞĐĞƐƐĂƌǇ͘�

dŚĞ�ĮƌƐƚ�ĐŚĂƌĂĐƚĞƌ�ŽĨ�ƚŚĞ�ƌĞƐŽƵƌĐĞ�ĐŽĚĞ�ŝŶĚŝĐĂƚĞƐ�ƚŚĞ�ƚǇƉĞ�ŽĨ�ĐŽƐƚ�ĂƐ�ĨŽůůŽǁƐ͗

͞�Ͳ�͟��>ĂďŽƌ

͞Ϯ͟�� DĂƚĞƌŝĂů

͞ϯ͟�� �ǆƉĞŶƐĞƐ

͞ϰ͟�� ^ƵďĐŽŶƚƌĂĐƚƐ

͞ϴ͟�� �ƋƵŝƉŵĞŶƚ

DĂƚĞƌŝĂů͕�ĞǆƉĞŶƐĞ͕�ĂŶĚ�ƐƵďĐŽŶƚƌĂĐƚ�ƌĞƐŽƵƌĐĞƐ�ĂƌĞ�ƐĞůĞĐƚĞĚ�ĨƌŽŵ�ƚŚĞ�
͞^ǇƐƚĞŵͲtŝĚĞ͟�DĂƚĞƌŝĂůͬKƚŚĞƌ�ZĞƐŽƵƌĐĞƐ�ĐŽĚĞďŽŽŬ͘��Ɛ�ƚŚĞǇ�ĂƌĞ�ƵƐĞĚ͕�ƚŚĞǇ�
ĂƌĞ�ĐŽƉŝĞĚ�ŝŶƚŽ�ƚŚĞ�͞>ŽĐĂů�DĂƚĞƌŝĂů͟�ĮůĞ�;ůŽĐĂů�ƚŽ�ƚŚŝƐ�ĞƐƟŵĂƚĞͿ͘�^Ž�ŝĨ�ǇŽƵ�
ƚĂŬĞ�ƚŚŝƐ�ĞƐƟŵĂƚĞ�ŚŽŵĞ�Žƌ�ƐĞŶĚ�ŝƚ�ƚŽ�ƐŽŵĞŽŶĞ�ĞůƐĞ͕�Ăůů�ŵĂƚĞƌŝĂů�ƵƐĞĚ�ŝŶ�ƚŚĞ�
ĞƐƟŵĂƚĞ�ĂƉƉĞĂƌ�ĂƐ�ƌĞƐŽƵƌĐĞƐ͘

Cost Code Examples
 ƒ ϭϬ��>�^^����KE�Z�d��ϮϭϭϬ��z�;�ŝĚŝƚĞŵͿ

 ƒ ��^Ğƚ�Θ�^ƚƌŝƉ�&ŽƌŵƐ�ϰϴϬϬϬ�^&�;�ĐƟǀŝƚǇͿ

 ƒ Ϯ&Dϳ�ĨŽƌŵ�ŵĂƚů�;ZĞƐŽƵƌĐĞͿ

 ƒ ϮZ�ϲϬ�ŐƌĂĚĞ�ϲϬ�ƌĞďĂƌ�;ZĞƐŽƵƌĐĞͿ

 ƒ ϴ,�Z�Ϯϱ�ƚ͘�ŚǇĚƌĂ�ĐƌĂŶĞ�ϭ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

 ƒ ϴt>��ǁĞůĚŝŶŐ�ŵĂĐŚŝŶĞ�ϭ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

 ƒ �&�ĐĂƌƉĞŶƚĞƌ�ĨŽƌĞŵĂŶ�ϭ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

 ƒ �:�ĐĂƌƉĞŶƚĞƌ�ũŽƵƌŶĞǇŵĂŶ�ϯ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

 ƒ >��ůĂďŽƌĞƌͲĐŽŵŵŽŶ�ϲ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

 ƒ K��ŽƉĞƌĂƚŽƌͲĐƌĂŶĞ�ϭ͘ϬϬ�;ZĞƐŽƵƌĐĞͿ

͞ϭϬ����&͟�ŝƐ�ƚŚĞ�ƵŶŝƋƵĞ�ĐŽƐƚ�ĐŽĚĞ�ƚŚĂƚ�ŝŶĚŝĐĂƚĞƐ�Ă��ĂƌƉĞŶƚĞƌ�&ŽƌĞŵĂŶ�ŝƐ�
ƵƐĞĚ�ŝŶ�ĂĐƟǀŝƚǇ��͕�ŝŶ�ďŝĚŝƚĞŵ�ϭϬ͘��ůů�ĐŽƐƚ�ĐŽĚĞƐ�ŝŶ�ĂĐƟǀŝƚǇ���ĂƌĞ�ƐƵŵŵĞĚ�ƚŽ�
ŐŝǀĞ�ƚŽƚĂůƐ�ĨŽƌ�ĂĐƟǀŝƚǇ��͘��ůů�ĂĐƟǀŝƟĞƐ�ŝŶ�ďŝĚŝƚĞŵ�ϭϬ�ĂƌĞ�ƐƵŵŵĞĚ�ƚŽ�ŐŝǀĞ�Ă�
ƚŽƚĂů�ĨŽƌ�ďŝĚŝƚĞŵ�ϭϬ͘

Folder Organization
Ͱ,��sz�/��ŝƐ�ƚŚĞ�ŵĂŝŶ�ĨŽůĚĞƌ

\EST ĐŽŶƚĂŝŶƐ�ĞƐƟŵĂƚĞƐ

Ͱ�^dD�^d�ŝƐ�ƚŚĞ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞ

Ͱ��DKD�^d�ŝƐ�ƚŚĞ�ĚĞŵŽ�ŵĂƐƚĞƌ�ĚĂƚĂ�ǁŚĞŶ�ŝŶƐƚĂůůĞĚ

ͰϵϳϬϭ�ŵŝŐŚƚ�ďĞ�ƚŚĞ�ĐŽĚĞ�ŽĨ�ĂŶ�ĞƐƟŵĂƚĞ

\9702 ŵŝŐŚƚ�ďĞ�ƚŚĞ�ĐŽĚĞ�ŽĨ�ĂŶŽƚŚĞƌ�ĞƐƟŵĂƚĞ

Ͱ,�^^�ĐŽŶƚĂŝŶƐ�^ǇƐƚĞŵͲtŝĚĞ��ĂƚĂ

Ͱ�/E�contains HeavyBid WƌŽŐƌĂŵƐ

Types of Data

System-Wide Data
�ĂƚĂ�ĂǀĂŝůĂďůĞ�ĨƌŽŵ�ĂŶǇ�ĞƐƟŵĂƚĞ͘�dŚĞƐĞ�ĮůĞƐ�ĂƌĞ͗

 ƒ DĂƚĞƌŝĂůͬKƚŚĞƌ�ZĞƐŽƵƌĐĞƐ��ŽĚĞďŽŽŬ�;ĞǆĐĞƉƚ�>ĂďŽƌ�Θ��ƋƵŝƉŵĞŶƚͿ

 ƒ Metric Conversion Rate

 ƒ �ŝƌĞĐƚŽƌǇ�ŽĨ��ƐƟŵĂƚĞƐ�ͬ��ƐƟŵĂƚĞ�DĂŶĂŐĞŵĞŶƚ

 ƒ �ŝĚŝƚĞŵ��ŽĚĞďŽŽŬ

 ƒ �ĐƟǀŝƚǇ��ŽĚĞďŽŽŬ

 ƒ hƐĞƌ�^ĞƚƵƉ

 ƒ ZĞƉŽƌƚ�,ĞĂĚŝŶŐ�^ĞƚƵƉ

 ƒ ^ǇƐƚĞŵͲtŝĚĞ�YƵŽƚĞ�&ŽůĚĞƌƐ

��������Ǧ�����ϐ�������
�ĂƚĂ�ƐƚŽƌĞĚ�ŝŶ�ǇŽƵƌ�ƉĂƌƟĐƵůĂƌ�ĞƐƟŵĂƚĞ�ĂŶĚ�ŶŽƚ�ĂǀĂŝůĂďůĞ�ŝŶ�ŽƚŚĞƌ�ĞƐƟŵĂƚĞƐ�
;ĞǆĐĞƉƚ�ǁŚĞŶ�ƵƐŝŶŐ�ƚŚĞ��ŽƉǇ��ĐƟǀŝƚǇ�ĨƵŶĐƟŽŶͿ͘�dŚĞƐĞ�ĮůĞƐ�ĂƌĞ͗

 ƒ �ƐƟŵĂƚĞ�/ŶĨŽƌŵĂƟŽŶ

 ƒ Labor

 ƒ �ĂůĞŶĚĂƌƐ�;ĨŽƌ�ůĂďŽƌ�ƉƌĞŵŝƵŵͿ

 ƒ >ĂďŽƌ�tŽƌŬ�ZƵůĞƐ�;ĨŽƌ�ƉƌĞŵŝƵŵͿ

 ƒ tŽƌŬĞƌƐ͛��ŽŵƉ�ZĂƚĞƐ

 ƒ �ƋƵŝƉŵĞŶƚ

 ƒ Crews

 ƒ >ŽĐĂů�DĂƚĞƌŝĂůͬKƚŚĞƌ�ZĞƐŽƵƌĐĞƐ

 ƒ �ŝĚŝƚĞŵƐ

 ƒ �ĐƟǀŝƟĞƐ

 ƒ �ŽƐƚ�ZĞƐŽƵƌĐĞƐ

 ƒ DĂƌŬƵƉ͕��ĚĚŽŶ͕�ĂŶĚ��ŽŶĚ�/ŶĨŽƌŵĂƟŽŶ

/ŶĨŽƌŵĂƟŽŶ�ƚŚĂƚ�ŝƐ�ƌĞƉĞĂƚĞĚ�ĂĐƌŽƐƐ�ĞƐƟŵĂƚĞƐ�ƐŚŽƵůĚ�ďĞ�ƐĞƚ�ƵƉ�ŝŶ�ƚŚĞ�DĂƐƚĞƌ�
�ƐƟŵĂƚĞ�ƐŽ�ƚŚĂƚ�ŝƚ�ŝƐ�ĐŽƉŝĞĚ�ŝŶƚŽ�ĞĂĐŚ�ŶĞǁ�ĞƐƟŵĂƚĞ͘
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Master Estimates
In HeavyBid͕�ĞƐƟŵĂƚĞƐ�ĂƌĞ�ĐƌĞĂƚĞĚ�ďǇ�ĐŽƉǇŝŶŐ�ĨƌŽŵ�ĂŶ�ĞǆŝƐƟŶŐ�ĞƐƟŵĂƚĞ͘�
�ƐƟŵĂƚĞƐ�ƚŚĂƚ�ĂƌĞ�ƵƐĞĚ�ƌĞŐƵůĂƌůǇ�ĨŽƌ�ƚŚŝƐ�ƉƵƌƉŽƐĞ�ĂƌĞ�ĐĂůůĞĚ�ŵĂƐƚĞƌ�
ĞƐƟŵĂƚĞƐ͘�tŚĞŶ�ƚŚĞ�ƐǇƐƚĞŵ�ŝƐ�ŝŶƐƚĂůůĞĚ͕�ƚŚĞƌĞ�ĂƌĞ�ƚǁŽ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞƐ͗

 ƒ �^dD�^d͗�/ŶƚĞŶĚĞĚ�ƚŽ�ďĞ�ǇŽƵƌ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞ͘�tŚĞŶ�,�^^�ƌĞĨĞƌƐ�ƚŽ�ƚŚĞ�
ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞ͕�ƚŚŝƐ�ŝƐ�ƚŚĞ�ĞƐƟŵĂƚĞ�ďĞŝŶŐ�ƌĞĨĞƌƌĞĚ�ƚŽ͘

 ƒ ��DKD�^d͗��ŽŶƚĂŝŶƐ�,�^^ͲƐƵƉƉůŝĞĚ�ĚĂƚĂ�ƚŚĂƚ�ǇŽƵ�ĐĂŶ�ĐŽƉǇ�ƚŽ�ƋƵŝĐŬůǇ�
ŵĂŬĞ�ƚĞƐƚ�ĞƐƟŵĂƚĞƐ͘�

��ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞ�ƚǇƉŝĐĂůůǇ�ĐŽŶƚĂŝŶƐ�ƌĞƐŽƵƌĐĞƐ͕�ďƵƚ�ŶŽ�ďŝĚŝƚĞŵƐ͕�ĂĐƟǀŝƟĞƐ͕�
Žƌ�ĐŽƐƚ�ĚĞƚĂŝů͘�/Ŷ�ŽƚŚĞƌ�ǁŽƌĚƐ͕�ŝƚ�ŝƐ�ĂŶ�ĞŵƉƚǇ�ĞƐƟŵĂƚĞ�ďƵƚ�ŽŶĞ�ǁŝƚŚ�ƌĞƐŽƵƌĐĞƐ�
ƌĞĂĚǇ�ĨŽƌ�ĞƐƟŵĂƟŶŐ͘�zŽƵ�ĐĂŶ�ŚĂǀĞ�ŵƵůƟƉůĞ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞƐ͖�ƚŚĞǇ�ĂƌĞ�
ŝĚĞŶƟĮĞĚ�ĂƐ�ŵĂƐƚĞƌƐ�ǁŚĞŶ�ƚŚĞ�ĞƐƟŵĂƚĞ�ŝƐ�ĐƌĞĂƚĞĚ�ĂŶĚ�ǁŚĞŶ�ǇŽƵ�ŽƉĞŶ�
ƚŚĞŵ�ŝŶ�ƚŚĞ�KƉĞŶ��ƐƟŵĂƚĞ�ǁŝŶĚŽǁ͘

Managing Estimates

Create Estimate (CTRL+C)
KŶ�ƚŚĞ�&ŝůĞ�ƚĂď͕�ƐĞůĞĐƚ�EĞǁ�х�EĞǁ��ƐƟŵĂƚĞ͘�dǇƉŝĐĂůůǇ͕ �ĂŶ�ĞƐƟŵĂƚĞ�ĐŽĚĞ�ĂŶĚ�
ĞƟŵĂƚĞ�ŶĂŵĞ�ĂƌĞ�ƚŚĞ�ŽŶůǇ�ƌĞƋƵŝƌĞĚ�ŝŶĨŽƌŵĂƟŽŶ͘

Open Estimate (CTRL+O)
 ƒ dŽ�ŽƉĞŶ�ĂŶǇ�ĞƐƟŵĂƚĞ͕�ƐĞůĞĐƚ�&ŝůĞ�ƚĂď�х�KƉĞŶ͘�/Ŷ�ƚŚĞ�KƉĞŶ��ƐƟŵĂƚĞ�
ǁŝŶĚŽǁ͕�ŶŽƚĞ�ƚŚĂƚ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞƐ�ĂƌĞ�ůŝƐƚĞĚ�ŽŶ�Ă�ƐĞƉĂƌĂƚĞ�ƚĂď͘

 ƒ dŽ�ŽƉĞŶ�Ă�ƌĞĐĞŶƚ�ĞƐƟŵĂƚĞ͕�ƐĞůĞĐƚ�&ŝůĞ�ƚĂď�х�ZĞĐĞŶƚ͘

zŽƵ�ĐĂŶ�ŽƉĞŶ�ĂŶŽƚŚĞƌ�ĞƐƟŵĂƚĞ�Ăƚ�ĂŶǇ�ƟŵĞ͘�&Žƌ�ĞǆĂŵƉůĞ͕�ǁŚŝůĞ�ǇŽƵ�ĂƌĞ�ŝŶ�
ƚŚĞ��ŝĚ�WƌŝĐŝŶŐ�ƐĐƌĞĞŶ�ĂŶĚ�ĐůŽƐŝŶŐ�ŽƵƚ�ƚŚƌĞĞ�ĞƐƟŵĂƚĞƐ͕�ǇŽƵ�ĐĂŶ�ĂůƚĞƌŶĂƚĞůǇ�
ŽƉĞŶ�ĞĂĐŚ�ĞƐƟŵĂƚĞ�ǁŝƚŚŽƵƚ�ůĞĂǀŝŶŐ�ƚŚĞ�ƐĐƌĞĞŶ͘

Delete Estimate
dŚŝƐ�ĂůǁĂǇƐ�ƌĞƋƵŝƌĞƐ�Ă�ƉĂƐƐǁŽƌĚ͘�/Ĩ�ƚŚĞ�ĞƐƟŵĂƚĞ�ĚŽĞƐ�ŶŽƚ�ŚĂǀĞ�Ă�ƉĂƐƐǁŽƌĚ͕�
ƵƐĞ�ƚŚĞ�ƐƚĂŶĚĂƌĚ�ƉĂƐƐǁŽƌĚ͗�͞�K��Z͘͟

Back Up Estimate
�ĂƚĂ�ŝƐ�ƐĂǀĞĚ�ŽŶƚŽ�ǇŽƵƌ�ŚĂƌĚ�ĚŝƐŬ�ĂƐ�ǇŽƵ�ǁŽƌŬ�ĂŶĚ�ŝƚ�ŝƐ�ƌĂƌĞ�ƚŚĂƚ�ǇŽƵ�ĐĂŶ�ůŽƐĞ�
ŵŽƌĞ�ĚĂƚĂ�ƚŚĂŶ�ŝƐ�ŽŶ�ǇŽƵƌ�ƐĐƌĞĞŶ�Ăƚ�ƚŚĞ�ƟŵĞ�ŽĨ�Ă�ƉŽǁĞƌ�ĨĂŝůƵƌĞ�Žƌ�ŽƚŚĞƌ�
ƉƌŽďůĞŵ͘�,ŽǁĞǀĞƌ͕ �ŝƚ�ŝƐ�ƉƌƵĚĞŶƚ�ƚŽ�ďĂĐŬ�ƵƉ�ǇŽƵƌ�ĚĂƚĂ�ĞǀĞƌǇ�ĨĞǁ�ŚŽƵƌƐ�ŽĨ�
ŚĞĂǀǇ�ĞŶƚƌǇ͘�hƐĞ�ƚŚĞ��ĂĐŬƵƉ�ŽƉƟŽŶ�ŽŶ�ƚŚĞ�&ŝůĞ�ƚĂď͘

�ĂƌƌǇ�ĂŶ�,�^^�ƐƵƉƉŽƌƚ�ĐĂƌĚ�ǁŝƚŚ�ǇŽƵ�ǁŚĞƌĞǀĞƌ�ǇŽƵ�ĞƐƟŵĂƚĞ͘�/ƚ�ĐŽŶƚĂŝŶƐ�
ŽƵƌ�Ϯϰͬϳ�ƐƵƉƉŽƌƚ�ŶƵŵďĞƌ�ĂƐ�ǁĞůů�ĂƐ�ŚŽŵĞ�ƉŚŽŶĞ�ŶƵŵďĞƌƐ�ŝŶ�ĐĂƐĞ�ŽĨ�ĂŶ�
ĞƐƟŵĂƟŶŐ�ĞŵĞƌŐĞŶĐǇ͘
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Glossary
activity
��ĨƵŶĐƟŽŶ�ŽĨ�ǁŽƌŬ�ƚŚĂƚ�ŵƵƐƚ�ďĞ�ĐŽŵƉůĞƚĞĚ�ƚŽ�ŵĂŬĞ�ƵƉ�ƉĂƌƚ�Žƌ�Ăůů�ŽĨ�Ă�
ďŝĚŝƚĞŵ͘�dŚĞƌĞ�ĐĂŶ�ďĞ�ŽŶĞ�Žƌ�ŵŽƌĞ�ĂĐƟǀŝƟĞƐ�ƉĞƌ�ďŝĚŝƚĞŵ͘�

bid quantity
dŚĞ�ƋƵĂŶƟƚǇ�ŽŶ�ƚŚĞ�ďŝĚ�ƉƌŽƉŽƐĂů�Žƌ�ƚŚĞ�ĚŽĐƵŵĞŶƚ�ƐƵďŵŝƩĞĚ�ƚŽ�ƚŚĞ�ŽǁŶĞƌ͘

biditem
�Ŷ�ŝƚĞŵ�ƌĞƋƵŝƌĞĚ�ďǇ�ƚŚĞ�ĐůŝĞŶƚ�ƚŽ�ďĞ�ƉĞƌĨŽƌŵĞĚ�ďǇ�ƚŚĞ�ĐŽŶƚƌĂĐƚŽƌ͘ �/ƚ�ŝƐ�ƉĂƌƚ�
ŽĨ�ƚŚĞ�ďĂƐŝƐ�ŽŶ�ǁŚŝĐŚ�ƚŚĞ�ĐŽŶƚƌĂĐƚŽƌ�ŝƐ�ƉĂŝĚ͘�/Ŷ�HeavyBid͕�ŝƚ�ĐĂŶ�ďĞ�Ă�ƉĂǇŝƚĞŵ͕�
Ă�ƉůĂĐĞ�ƚŽ�ƉƵƚ�ŽǀĞƌŚĞĂĚ�ĐŽƐƚƐ͕�Žƌ�ŝƚ�ĐĂŶ�ƌĞƉƌĞƐĞŶƚ�Ă�ůŝŶĞ�ŽĨ�ƚĞǆƚ�ŽŶ�Ă�ďŝĚ�
ƉƌŽƉŽƐĂů͘

burden
�ůů�ĂĚĚŝƟŽŶĂů�ĐŽƐƚƐ�ƚŚĂƚ�ĂƌĞ�ŝŶĐƵƌƌĞĚ�ŽǀĞƌ�ĂŶĚ�ĂďŽǀĞ�ƚŚĞ�ĂĐƚƵĂů�ďĂƐĞ�ƌĂƚĞ�ĨŽƌ�
Ă�ƉĂƌƟĐƵůĂƌ�ůĂďŽƌ�ĐƌĂŌ͘�dŚŝƐ�ŝŶĐůƵĚĞƐ͕�ďƵƚ�ŝƐ�ŶŽƚ�ůŝŵŝƚĞĚ�ƚŽ͕�ǁŽƌŬĞƌƐ͛�ĐŽŵƉ͕͘�
ĨƌŝŶŐĞƐ͕�ƚĂǆĞƐ͕�ĂŶĚ�ƉĞƌ�ĚŝĞŵ�ĐŽƐƚ͘�

child biditem
�Ŷ�ŝƚĞŵ�ƚŚĂƚ�ŚĂƐ�ĂĐƟǀŝƟĞƐ�ĂŶĚ�ƌĞƐŽƵƌĐĞƐ͕�ďƵƚ�ƐƵŵƐ�ƵƉ�ǁŝƚŚ�ŽƚŚĞƌ�ĐŚŝůĚ�
ŝƚĞŵƐ�ƚŽ�Ă�͞ƉĂƌĞŶƚ͟�ŝƚĞŵ͘��ŚŝůĚ�ŝƚĞŵƐ�ĚŽ�ŶŽƚ�ƐŚŽǁ�ŽŶ�Ă�ďŝĚ�ĨŽƌŵ͘

client number
dŚĞ�ŽǁŶĞƌ Ɛ͛�ŽĸĐŝĂů�ŶƵŵďĞƌ�ĨŽƌ�Ă�ƉĂƌƟĐƵůĂƌ�ďŝĚŝƚĞŵ͘

construction material
DĂƚĞƌŝĂů�ƚŚĂƚ�ŝƐ�ƵƐĞĚ�ŽŶ�Ă�ƉƌŽũĞĐƚ�ĂŶĚ�ŝƐ�ĚĞƐƚƌŽǇĞĚ�ĚƵƌŝŶŐ�ĐŽŶƐƚƌƵĐƟŽŶ�Žƌ�
ƌĞŵŽǀĞĚ�ǁŚĞŶ�ŝƚ�ŝƐ�ĮŶŝƐŚĞĚ�;Ğ͘Ő͕͘�ĨŽƌŵǁŽƌŬ͕�ƚƌĂĸĐ�ďĂƌƌŝĐĂĚĞƐͿ͘

crew
dǇƉŝĐĂůůǇ͕ �Ă�ŐƌŽƵƉŝŶŐ�ŽĨ�ůĂďŽƌ�ĂŶĚ�ĞƋƵŝƉŵĞŶƚ�ƚŚĂƚ�ǁŽƌŬ�ƚŽŐĞƚŚĞƌ�ŝŶ�ĂŶ�
�ĐƟǀŝƚǇ͘�dŚĞ�ĐƌĞǁ�ŚĂƐ�ĂŶ�ĂƐƐŽĐŝĂƚĞĚ�ƉƌŽĚƵĐƟŽŶ�ƚǇƉĞ�ĂŶĚ�ƌĂƚĞ�ƚŚĂƚ�ĐĂůĐƵůĂƚĞƐ�
ƚŚĞ�ŚŽƵƌƐ�ƚŚĂƚ�ŐĞŶĞƌĂƚĞ�ƚŚĞ�ĐŽƐƚƐ͘

direct biditem
��ďŝĚŝƚĞŵ�ƚŚĂƚ�ǇŽƵ�ǁŝůů�ďĞ�ĚŝƌĞĐƚůǇ�ƉĂŝĚ�ĨŽƌ͖�Ă�ďŝĚ�ƉƌŽƉŽƐĂů�ŝƚĞŵ͘

equipment account
��ďŝĚŝƚĞŵ�ƵƐĞĚ�ƚŽ�ŐĞŶĞƌĂƚĞ�ƚŚĞ�ƌĞŶƚ�ŽĨ�ĂŶ�ĞƋƵŝƉŵĞŶƚ�ƉŝĞĐĞ�ŝŶ�ƚŚĞ�ĞƐƟŵĂƚĞ͘�
�Ŷ�ĞƋƵŝƉŵĞŶƚ�ĂĐĐŽƵŶƚ�ďŝĚŝƚĞŵ�ŵƵƐƚ�ďĞ�ƵƐĞĚ�ŝŶ�ĐŽŶũƵŶĐƟŽŶ�ǁŝƚŚ�ĂŶ�
�ůƚĞƌŶĂƚĞ�ZĞŶƚ��ĂůĐƵůĂƟŽŶ͘�

fuel rate
dŚĞ�ĚŽůůĂƌ�ǀĂůƵĞ�ĐŽƐƚ�ŽĨ�ĨƵĞů�ƚŽ�ƌƵŶ�ĞƋƵŝƉŵĞŶƚ�ƉĞƌ�ƵŶŝƚ͘�/Ŷ��ĂƐŝĐ�ƐǇƐƚĞŵƐ�
ĂŶĚ�ďĞůŽǁ͕�ƚŚŝƐ�ǀĂůƵĞ�ŝƐ�ƚǇƉŝĐĂůůǇ�ƵƐĞĚ�ĨŽƌ�Ăůů�ĞƋƵŝƉŵĞŶƚ�ŽƉĞƌĂƟŶŐ�ĞǆƉĞŶƐĞƐ�
;�K�Ϳ�ĞƋƵŝƉŵĞŶƚ�ƐĞƚƵƉ͘

holding account
��ďŝĚŝƚĞŵ�ǁŚĞƌĞ�ĐŽƐƚ�ŝƐ�ŐĂƚŚĞƌĞĚ�ŝŶ�ŽƌĚĞƌ�ƚŽ�ƐƉƌĞĂĚ�ďĂĐŬ�ƚŽ�ƐƉĞĐŝĮĐ�
ďŝĚŝƚĞŵƐ͕�ďĂƐĞĚ�ŽŶ�ƋƵĂŶƟƚǇ�ŽĨ�ƵŶŝƚƐ�ŝŶ�ĞĂĐŚ�ŝƚĞŵ͘

indirect biditem
��ďŝĚŝƚĞŵ�ƚŚĂƚ�ĐŽůůĞĐƚƐ�Ăůů�ĐŽƐƚƐ�ƚŚĂƚ�ŶĞĞĚ�ƚŽ�ďĞ�ŝŶ�ƚŚĞ�ĞƐƟŵĂƚĞ͕�ďƵƚ�ǇŽƵ�
ĂƌĞ�ŶŽƚ�ďĞŝŶŐ�ĚŝƌĞĐƚůǇ�ƉĂŝĚ�ĨŽƌ͘ �dŚĞƐĞ�ĐŽƐƚƐ�ǁŝůů�ďĞ�ƐƉƌĞĂĚ�ďĂĐŬ�ƚŽ�ƚŚĞ�ĚŝƌĞĐƚ�
ďŝĚŝƚĞŵƐ�Ăƚ�ƚŚĞ�ĞŶĚ�ŽĨ�ƚŚĞ�ĞƐƟŵĂƟŶŐ�ƉƌŽĐĞƐƐ�ďĂƐĞĚ�ŽŶ�ƐƉƌĞĂĚ�ŝŶƐƚƌƵĐƟŽŶƐ͘�
dŚĞƐĞ�ďŝĚŝƚĞŵƐ�ĚŽ�ŶŽƚ�ĂƉƉĞĂƌ�ŽŶ�ƚŚĞ�ďŝĚ�ƉƌŽƉŽƐĂů

inside rent
dŚĞ�ĐŽƐƚ�ŽĨ�ŽǁŶĞƌƐŚŝƉ�ƉĞƌ�ƵŶŝƚ�ĨŽƌ�Ă�ƉŝĞĐĞ�ŽĨ�ĞƋƵŝƉŵĞŶƚ͘

local
�ĂƚĂ�Žƌ�ƌĞƐŽƵƌĐĞ�ĞǆŝƐƚƐ�ĂŶĚ�ĐĂŶ�ďĞ�ĐŚĂŶŐĞĚ�ŽŶůǇ�ŝŶ�ƚŚĞ�ĐƵƌƌĞŶƚ�ĞƐƟŵĂƚĞ

library biditem
��ďŝĚŝƚĞŵ�ƚŚĂƚ�ƌĞƐŝĚĞƐ�ŝŶ�Ă�ůŝďƌĂƌǇ�ĞƐƟŵĂƚĞ͘�dŚŝƐ�ŝƚĞŵ�ƚǇƉŝĐĂůůǇ�ŚĂƐ�ŵŽƌĞ�
ƚŚĂŶ�ŽŶĞ�ĂĐƟǀŝƚǇ�ĂŶĚ�ŝƐ�ĐŽŵƉůĞƚĞůǇ�ǁŽƌŬĞĚ�ƵƉ�ǁŝƚŚ�Ăůů�ĐƌĞǁƐ͕�ƉƌŽĚƵĐƟŽŶ�
ƌĂƚĞƐ͕�ŵĂƚĞƌŝĂůƐ͕�ĂŶĚ�ƐƵďƐ�ŶĞĐĞƐƐĂƌǇ�ƚŽ�ĐŽŵƉůĞƚĞ�ƚŚĞ�ŝƚĞŵ͘�dŚĂƚ�ŝƚĞŵ�ŝƐ�ƚŚĞŶ�
ůŝŶŬĞĚ�ƚŽ�ĂŶ�ĂƐƐŽĐŝĂƚĞĚ�ďŝĚŝƚĞŵ�ĐŽĚĞďŽŽŬ�ŝƚĞŵ�ĂƐ�Ă�ĚĞĨĂƵůƚ͘�

library estimate
�Ŷ�ĞƐƟŵĂƚĞ�ĐŽŶƚĂŝŶŝŶŐ�Ă�ůŝƐƚ�ŽĨ�ĨƌĞƋƵĞŶƚůǇ�ƵƐĞĚ�ďŝĚŝƚĞŵƐ�ƚŚĂƚ�ĂůƌĞĂĚǇ�
ĐŽŶƚĂŝŶ�ĐŽƐƚƐ�;ĂĐƟǀŝƟĞƐ�ĂŶĚ�ƌĞƐŽƵƌĐĞƐͿ�ƚŚĂƚ�ǇŽƵ�ĐĂŶ�ĐŽƉǇ�ŝŶƚŽ�ĂŶŽƚŚĞƌ�
ĞƐƟŵĂƚĞ͘�zŽƵ�ĐĂŶ�ŽŶůǇ�ŚĂǀĞ�ŽŶĞ�ůŝďƌĂƌǇ�ĞƐƟŵĂƚĞ�ƉĞƌ�ƐǇƐƚĞŵ͘�

master estimate
��ƚĞŵƉůĂƚĞ�ŽĨ�ŝŶĨŽƌŵĂƟŽŶ�ƚŚĂƚ�ŝƐ�ĐŽŵŵŽŶ�ƚŚƌŽƵŐŚŽƵƚ�Ăůů�ĞƐƟŵĂƚĞƐ͘�dŚŝƐ�
ŝŶĨŽƌŵĂƟŽŶ�ŝŶĐůƵĚĞƐ͕�ďƵƚ�ŝƐ�ŶŽƚ�ůŝŵŝƚĞĚ�ƚŽ͕�ůĂďŽƌ�ĐŽƐƚƐ͕�ĞƋƵŝƉŵĞŶƚ�ĐŽƐƚƐ͕�
ĐƌĞǁƐ͕�ĂŶĚ�ƚĂǆĞƐ͘�dŚĞ�ŵĂƐƚĞƌ�ŝƐ�ƵƐĞĚ�ĂƐ�Ă�ďĂƐŝƐ�ĨŽƌ�ĐƌĞĂƟŽŶ�ŽĨ�Ăůů�ŽƚŚĞƌ�
ĞƐƟŵĂƚĞƐ͘�zŽƵ�ĐĂŶ�ŚĂǀĞ�ĂƐ�ŵĂŶǇ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞƐ�ĂƐ�ŶĞĐĞƐƐĂƌǇ͘�KŶĞ�ŽĨ�ƚŚĞ�
ŵĂŝŶ�ƌĞĂƐŽŶƐ�ƚŽ�ŚĂǀĞ�ŵŽƌĞ�ƚŚĂŶ�ŽŶĞ�ŵĂƐƚĞƌ�ĞƐƟŵĂƚĞ�ŝƐ�ŚĂǀŝŶŐ�ŵŽƌĞ�ƚŚĂŶ�
ŽŶĞ�ƐĞƚ�ŽĨ�ůĂďŽƌ�ƌĂƚĞƐ͘

non-additive biditem
��ďŝĚŝƚĞŵ�ƚŚĂƚ�ĚŽĞƐ�ŶŽƚ�ĂĚĚ�ŝŶƚŽ�ƚŚĞ�ƚŽƚĂů�ĐŽƐƚ�ŽĨ�ƚŚĞ�ĞƐƟŵĂƚĞ͘�

outside rent
dŚĞ�ĐŽƐƚ�ŽĨ�ƌĞŶƟŶŐ�ƚŚĞ�ĞƋƵŝƉŵĞŶƚ�ƉĞƌ�ƵŶŝƚ͘

parent biditem
��ƉĂǇ�ŝƚĞŵ�ƚŚĂƚ�ŝƐ�ǀĞƌǇ�ďƌŽĂĚ�ŝŶ�ƐĐŽƉĞ͘�/ƚ�ƌĞƋƵŝƌĞƐ�ƐƵďĚŝǀŝĚŝŶŐ�ŝŶƚŽ�ƚǁŽ�Žƌ�
ŵŽƌĞ�ĐŚŝůĚ�ŝƚĞŵƐ�ŝŶ�ŽƌĚĞƌ�ƚŽ�ƚŚŽƌŽƵŐŚůǇ�ĞƐƟŵĂƚĞ�ƚŚĞ�ǀĂůƵĞ͘�dŚĞ�ƉĂƌĞŶƚ�ŝƚĞŵ�
ƐŚŽǁƐ�ŽŶ�Ă�ďŝĚĨŽƌŵ�ĂŶĚ�ŝƐ�Ă�ƐƵŵ�ŽĨ�Ăůů�ƚŚĞ�ĐŚŝůĚ�ŝƚĞŵƐ�ƵŶĚĞƌ�ŝƚ͘�

permanent material 
DĂƚĞƌŝĂů�ƚŚĂƚ�ŝƐ�ƵƐĞĚ�ŽŶ�ƚŚĞ�ũŽď�ĂŶĚ�ƌĞŵĂŝŶƐ�ŝŶ�ƉůĂĐĞ�;Ğ͘Ő͕͘�ĂŐŐƌĞŐĂƚĞƐ͕�
ĂƐƉŚĂůƚ͕�ĚŝīĞƌĞŶƚ�ƚǇƉĞƐ�ŽĨ�ƉŝƉĞͿ͘

rent rate
dŚĞ�ĚŽůůĂƌ�ǀĂůƵĞ�ĐŽƐƚ�ŽĨ�ŽǁŶĞƌƐŚŝƉ�Žƌ�ƌĞŶƚĂů�ĐŽƐƚ�ƉĞƌ�ƵŶŝƚ�ĨŽƌ�ĞƋƵŝƉŵĞŶƚ͘

resource
�ĂŶ�ďĞ�Ă�ůĂďŽƌ�ĐƌĂŌ͕�ƉŝĞĐĞ�ŽĨ�ĞƋƵŝƉŵĞŶƚ͕�ŵĂƚĞƌŝĂů͕�Žƌ�ƐƵďĐŽŶƚƌĂĐƚŽƌ͘ �/ƚ�ŝƐ�ƚŚĞ�
ůŽǁĞƐƚ�ůĞǀĞů�ŽĨ�ĚĞƚĂŝů�ŝŶ�ƚŚĞ�ĞƐƟŵĂƚĞ�ĂŶĚ�ŝŶĐůƵĚĞƐ�ĐŽƐƚƐ͘�

self-performed work
ZĞĨĞƌƐ�ƚŽ�ƚŚĞ�ĐŽƐƚ�ŽĨ�ǁŽƌŬ�ǇŽƵ�ǁŝůů�ƉĞƌĨŽƌŵ͕�ĂƐ�ĐŽŵƉĂƌĞĚ�ƚŽ�ƚŚĞ�ĐŽƐƚ�ŽĨ�ƚŚĞ�
ƐĂŵĞ�ǁŽƌŬ�ŝĨ�ƉĞƌĨŽƌŵĞĚ�ďǇ�Ă�ƐƵďĐŽŶƚƌĂĐƚŽƌ͘

system-wide
�ĂƚĂ�ĂŶĚ�ƐĞƫŶŐƐ�ƚŚĂƚ�ĂƌĞ�ŶŽƚ�ƐƉĞĐŝĮĐ�ƚŽ�ŽŶĞ�ĞƐƟŵĂƚĞ͘

takeoff quantity
dŚĞ�ƋƵĂŶƟƚǇ�ǇŽƵ�ĂĐƚƵĂůůǇ�ĞǆƉĞĐƚ�ƚŽ�ŐĞƚ�ƉĂŝĚ�ĨŽƌ�ƌĂƚŚĞƌ�ƚŚĂŶ�ƚŚĞ�ƋƵĂŶƟƚǇ�
ƚŚĂƚ�ǇŽƵ�ĂƌĞ�ƋƵŽƟŶŐ͘
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More Learning Options

Help Videos
Click this icon to watch help videos for 
the screen you are currently viewing in 
HeavyBid. Available on select windows and 
on the Help tab.

Context-Sensitive Help
Press the F1 key to access help for the 
screen you are currently viewing in 
HeavyBid. You can also access help from the 
Help tab.

On-Screen Tutorial
To follow an on-screen tutorial, select 
the Tutorial option from the Help tab or 
Welcome Screen.

What’s New in HeavyBid
Click the What’s New tab to view new 
features and enhancements in each release 
of HeavyBid.

Training
+&66�SURYLGHV�PDQ\�WUDLQLQJ�RSWLRQV�WR�¿�W�DOO�QHHGV�
and budgets. For details, call 800-683-3196 or e-mail us 
at training@hcss.com.

Online Articles
View technical articles in “The Knowledge Base” at 
www.myhcss.com.

User’s Group Meetings
Attend our annual User’s Group Meetings to network 
with hundreds of industry peers from across the nation, 
choose from a variety of classes, and meet the entire 
HCSS staff. Also preview new features and products, 
vote on future development, and have a good time in 
Texas. Visit www.hcss.com for details.

24/7 Technical Support
Your HCSS Support Team is standing by 24/7. Give us 
a call at 800-444-3196.
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